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Introduction to UWP IDE

Content

This chapter includes the following sections:

DS I D I ON . 10
Main fEatUIES 11
Interface StrUCIUNe . 12
CoNNECHON PrOfil S . 15
What are l0CatioNS . 17
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Description

The UWP IDE user interface is the result of our experience in adapting user needs to specific use cases.

Being UWP 4.0 a solution for energy efficiency management, in the comprehensive realm of functions for energy
monitoring, light control, remote actuation, data automation, user interaction, loT integration, we have focused on
finding the best way to make sure that simple things are simple and complex things are possible.

The interface has been built using a clear header, a body split into 3 sections according to a master / detail
concept, so to guide users to the needed area.

Each object (i.e., devices, functions, variables) is represented by an icon and the same icon with the same
meaning is used in both UWP IDE and the UWP 4.0 Web-App, so to provide users with a consistent experience.

UWP IDE | User manual v. 5.0 13/11/2023| | © 2023 CARLO GAVAZZ| Controls SpA 10



Main features

UWP IDE is the UWP 4.0 configuration software. It allows the user to:
» carry out the system commissioning
« define the automation and control logics

» setthe measuring instruments and sensors monitoring.
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Interface structure
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Element Description

File menu including:
« Buttons for opening, creating or saving a project

o Project, template and IDE settings

« Report manager.

From this window you can export PDF reports containing installation details. Following
are the four types of report:

« The Plant report shows you the information about the part numbers you have in
your project (subnet and address).

« The Bill of materials shows you the quantity of each part number you included
into your project.

« The Data logging report shows you the logging details of each signal.
« The Web API functions report shows you all APl commands.

+ General info about IDE
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Description

Element
Navigation bar including:
« Controller menu.
This area contains the EEE Connections menu that permits you to:
« find the connected controllers
« create predefined profiles
« manage the controller connection profiles.
See Connection profiles.
« Project editing menus.
This area contains the following menus:
iaa Function list, depending on the application you select ( Building or
u{-;
Energy).
Note: to enable the list you MUST select at least one of the two applications.
: |
Module manager, that permits you to:
« find modules connected to your controller (automatically)
« add manually modules (from >> Templates)
B

« create drivers (see Driver management)

« create locations that you can also manage from Home page > Project

) & Gateway, that permits you to open the BACnet or Modbus configuration
window.

[
)
¢ Compile, that permits you to save your project to be sent to the controller.

« Project management menu
When you connect to your controller, if there is an update available, a warning appears.

These menus are available only if your controller is connected.
From this area you can perform the following actions:

:‘0 If you click w, you can set the options for sending your configuration to your
controller

I

Upload the configuration from the connected controller

Enable the live signals to see the real time status of the system. Itis
available only when the IDE is connected to the controller.
The user can check at any time the status of all analogue values coming
from all the sensors in the installation.
Note: when the Live signals are activated, all the other actions are disabled (only
saving the project is allowed).
UWP IDE | User manual v. 5.0 | 13/11/2023 | UWP IDE | © 2023 CARLO GAVAZZI Controls SpA
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Element Description

C Progress of the project compiling, sending and of the reading from your controller.
Project and controller parameters.
The Project tab permits you to manage (i.e., add, delete, move) the following project
elements:

D « the locations.
« the functions, and the relevant statuses
« the modules, and the relevant signals
The Controller tab permits you to set the controller parameters.
From this area you can see what you configure in the Project tab (see element D) and
interact with the different elements. The tabs that compose it are the following:

£ « Functions
« Modules networks, containing the Modules and the relevant signals of your project
« Highlight objects, containing pages that you can create to see the desired functions /

modules / signals all together.

This area changes according to what you select from the central area (element D). The
available tabs are the following:
Logs, that shows the log errors (red icon, blocking the configuration), warnings (orange
icon) or information (green icon) during the configuration compiling.

F Function, that is available if you select a function and if you enable the live signals. It
shows the function properties and permits you to execute commands.
Device, that is available if you select a device and shows the relevant properties.
Signals, that is available if you select a module and shows the relevant variables.

G Contextual Help

H Right part: dynamic icons giving information about the controller

UWP IDE | User manual v. 5.0 13/11/2023| | © 2023 CARLO GAVAZZ| Controls SpA
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Connection profiles

The 'FE-‘&' Connections window manages the profiles to connect to UWP.
You can open it in two ways:

from the Home page by clicking ‘f'_E-t' Connections
« from the bottom left part of the interface.

Two areas compose the window:

» the right area permits you to discover the controllers connected to a LAN network and to add them to your
profile list

« the left area permits you to manually add a profile without using the Discovery function
For each profile you can edit the IP address and the ports that the UWP IDE uses for the controller programming.

The MAC address field is not mandatory and usually it is updated whenever you use the Discovery function for the
LAN network controller (right area).

Please consider the picture below representing a discovery result:

; 1% Controller Connertions Management IB] - o x
e

A Connrytian Prafiles Comaralies Discewery
@D | [ Avaiabie e Nietwors = |D|—
Porm 1 Part 2 Part Ethemet 2 19218813253 L J

Hama P Asdsiress MAC F2188132.53

92162254254 5326 10000 10002 v &

1 1 Etmemet & 1001988
Dewre it 1 00542 00-15-EE-10-T2-16 52328 10000 10002
Otfce 0043 52326 1000 10002 1P Addeess - Mal Ferraare version Name

s s [ — \ vwpaoeso E
C * UWPIORSEXNX L J

» VMUCEM

4 UWPD

10.0.542
P
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Area Description

Adds a new connection profile to your list.

Once you have added and saved one, the software shows it in and permits to select it from the
bottom part of the interface (see picture below).
= File Home

&% OH @ & o

Connections | Energy Building Medule Function Gateway
Manager list™ v

Controller Project Editing

Project tree Controller

. 20

Ref Name
17 M 11 Default
‘ System
»[J&, @i K RS4851 Modbus master
v M ke cPaosOAC

[E) oefaur D1 92.168.254254 [

B 9 Imports an existing listand [ Exports a new list of profiles.
—© —®
Shows the list of known connection profiles.

C
Note: the default one is set through micro-USB.
D Shows the list of available network interface(s): you can flag one and click 'ﬂ%‘h to start the
UWP 4.0 modules discovery.
Notice: UWP must be connected to the same network.
E 'ﬁ%‘ﬁ Starts the UWPs discovery

®Adds the selected UWP to the list on the left
F  List of found modules you can add to your list on the left
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What are locations

Locations are containers of objects that can be modules, functions or other nested locations.
They permit you to hierarchically organise your project objects to be easily found.

Note that the use of locations is not mandatory but highly recommended.
Example of location hierarchy

Carlo gavazzi Controls
Ground floor

Office UTC

Open space R&D
Meeting room 1
Meeting room 2
Bathroom 1
Bathroom 2

Main Cabinet

(#])

SBPZMCG324

SHPINCNTS04
SH2RE16A4
SHPINY324

(8 &D 4

First floor

UTC Office

=k B E EF S Eb S EF B 5 Bl B EF B EF Bb

Light open space UTC
Main status

Status signal

Custom signal

In this example, the Carlo Gavazzi Controls building is composed of two floors (Ground and First). For each floor, there are
several rooms to be managed and controlled.

To do that, in the Ground floor seven locations have been added for each room: for controlling the Main Cabinet, four
modules have been added.

In the First floor, the UTC Office location has been added to control the relevant light system.
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DALI-2 gateway

Content
This chapter includes the following sections:

How to access the DALI-2 gateway Settings ... ...
DALI-2 gateway WiNQOW ... ..
PO CEAUIES .
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How to access the DALI-2 gateway
settings

After you have added a DALI-2 device to your project (see how to add a control gear / control device automatically
or manually), you can access the DALI network programming: click the DALI-2 tab that appears if you select a

DALI-2 device from the Modules networks tab.

Module manager

DERME B & {8 B B kik

Home 5Save and Energy Building | Discovery R5485 R5485 Serial to IP Bus DALI-2 | LoRa Excel
Home - COM1 COM2 converter™ generators™ Gateway File =
Add subnet Import

Discovery

Templates Discovered

@2

Part Number SIN Add Fw rev State Path

Clicking the DALI-2 tab will open the DALI network window that shows the related data (if available) loaded from
the gateway memory.
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DALI-2 gateway window
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Three main sections compose the DALI-2 gateway programming window:

1. List of control gears (output devices). This section is also split into two areas:
1.a. Project signals
1.b. Information/settings read from field by the control gear

2. List of control devices (input devices). This section is also split into two areas:
2.a. Project signals
2.b. Information/settings read from field by the control device

3. Support right panel containing the following parts:
« General Commands
« Details of the control gear selected from the Control gear tab (section 1)

« Details of DALI groups according to the subscriptions applied to the control gears from the DALI
groups tab (section 1)

« Details of the device or instance selected from the Control gear tab (section 1)

Control gears section

How to add control gears to the DALI-2 window

Manually add a control gear by clickin % in the upper right (see the picture below): it opens a panel to
select the signals with SA not yet used.

UWP IDE | User manual v. 5.0 13/11/2023| | © 2023 CARLO GAVAZZ| Controls SpA 20



<

Module manager

(ARSI :

Home Save and Energy Building | Discovery | RS485 R5485
Home b COM1 COM2

Discovery

o000 —

« Automatically add a control gear by using the discovery function (Commands tab on the right).

t(r)]nce a)control gear has been created it remains in the list, and can be removed using @- (on the right part of
e row).

Control gear table(s)
For each control gear you create a row appears in the table; each row is split into three parts:

Blobulen networhn (10

foGaaroe p——T—y;

e gy Ofire weigeen. 82 ek L] i Fetewec Faseoer 900 062 OO0 OBd OO O04 007 OO OG8 G0 G171 G 310 ) liowee S Lot o

Wl sesitecd ™ -

="
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Element Description

1 Signal(s) to be used in the project. The control gear signals appear in the project if the
Link field is flagged or if from the Offline configuration column one of the options (i.e.,
Reserved (type 6) or Reserved (type 8)) is selected.

The table below describes each column of this section:

Column name Description

Index Signal index in the table

Name Signal name in the project

Offline It allows to display a signal in the project even if you have not executed

configuration the DALI network discovery or the link is not active (offline
configuration).

There three options available:

1. Not reserved. The signalis visible in the project only if the
information about the field control gear is available and if the Link
column is flagged.

2. Reserved (type 6). The signal is visible in the project even if the
information about the field control gear is not available, but the link
is not active.

3. Reserved (type 8). The signal is visible in the project even if the
information about the field control gear is not available, but the link
is not active.

SA The DALI short address of the project signal. It takes the field control
gear value if it is available or changed.

Link It allows to combine the project signal with the field control gear. If the
check box is set to OFF, the field control gear is not linked to the
project signal.

To use the project signal in the functions, there must be a link to a field
signal.
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Element Description

2 Information/settings read from the field by the control gear. The data shown in this section
may have been read by field devices or downloaded from the configuration file. For this
reason, it is useful to have information about the origin of the data and about the last
command sent to each device.

The table below describes each column of this section:

Column

name Description
SA DALI short address of the field signal
Type DALLI device type
Phy min  Physical minimum level of the control gear (value from 0 to 254)
Min / Minimum/maximum applicable level.
Max Note: the minimum settable value is = Phy min level; the maximum is = 254.
PON = Power on level.

Itis the brightness value that the DALI driver assumes as soon as the
power supply is turned on.

Note: if the value is set to 255, the luminaries should keep their current/last
value.

SYS = System failure level.

Itis the brightness value that the DALI driver assumes when an error is
detected in the DALI circuit (e.g., interruption or short-circuit on the DALI
line).

Note: if the value is set to 255, the luminaries should keep their current/last
value.

Fade time Time in seconds for fading from the current brightness value to the new
brightness value (for light level and scene commands).

Note: do not set to NULL because you will disable the fading.

Fade rate Fade steps per second used during manual dimming (speed for dimming
Up or Down)

G01..016 DALI group assignment of the DALI driver
S01..016  DALI level saved for the DALI scene

Phy CT Physical minimum/maximum colour temperature of the control gear

min/max

CT Minimum/maximum applicable colour temperature.

min/max Note: the minimum settable value is = Phy CT min level; the maximum is = Phy

CT max level.

CT PON = Colour temperature Power on level.
Itis the colour temperature value that the DALI driver assumes as soon as
the power supply is turned on.

CT SYS = Colour temperature System failure level.
It is the colour temperature value that the DALI driver assumes when an
error is detected in the DALI circuit (e.g., interruption or short-circuit on the
DALlI line).

3 User’s feedbacks.
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Control devices section

How to add control devices to the DALI-2 window

Manually, by clicking the button in the upper right Q‘B: it opens a panel to select the control devices
(maximum controlled devices: 32).

« Automatically, by using the discovery function (Commands tab on the right).

tOhnce a)control device has been created it remains in the list, and can be removed using @- (on the right part of
€ row).

Control device table(s)
For each control device you create a row appears in the table; each row is split into two parts:

s 13 e A = bl -ui.‘l - L L L LT T UnNITs . 5
o
a
8
Element Description
1 Signal(s) to be used in the project.
The table below describes each column of this section:
Column o
name Description
Index Signal index in the table
Type Object type
Project  Signal name in the project
name
SA The DALLI short address of the project signal. It takes the field control

device value if it is available or changed.
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Element Description

2 Information/settings read from the field by the control device.
The table below describes each column of this section:

Column name Description
SA DALI short address of the field signal
Enable Signal/instance enable status.

Flag it to use it in the UWP function.

GTIN Manufacturer GTIN number
uiD Manufacturer unique ID
FW Manufacturer firmware version
HW Manufacturer hardware version.
DALI standard Notes about the supported standards

Commands section

Control gears and device commands

The table below describes each column of the Control gears and device commands section.

Command Description

Initialize all Searches for all control gears/devices connected to the DALI network.

devices After that, each device connected to the network generates again its random address
and the DALI-2 master assigns it new SA (short address).

Note: the SA assignment starts from 0 and increases for each device found randomly.

Initialize Searches for new control gears/devices connected to the DALI network.
new After that, each device without a valid SA (usually the brand-new modules) generates
devices again its random address and the DALI-2 master assigns it a new SA.

Note: the DALI devices with a valid SA are not changed.
Read all Searches for new control gears/devices connected to the DALI network by scanning all
devices SAs.

Note: no device generates its random address and changes its SA.

Control gears commands
The table below describes each column of the Control gears commands section.

Command Description
Target Selects the command target among those available:
address

« Broadcast = message to all devices on the DALI line

« Group xx= only the control gears that belong to this group react

¢ SA xx = only the control gear that has the SA reacts

o Use SA of selected row = the command is sent to the selected control gear
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Command Description

Action Action that the target will execute, among those available:

 Off = turns off the light

« Up=increments by one the output level (only if light is ON)

« Down= decrements by one the output level (only if light is ON)

» Recall min level= sets output level to minimum value

« Recall max level= sets output level to maximum value

« Step Up=increments by one the output level (if the light is OFF, the light is also
turned ON automatically)

« Step Down= decrements by one the output level (if the light is OFF, the light is also
turned ON automatically)

« On and step up=increments by one the output level (if the light is OFF, the light is
also turned ON automatically)

» Step down and off=decrements by one the output level (if the light is ON, the light is
also turned OFF automatically)

« Go to scene= sets the light level to the value selected in the field “Scene to activate”

« Goto last active level= sets the light level to the last value saved before turning

OFF.

« Direct level= sets the light level to the value selected in the field “Direct level to be
applied”

« |dentify command = makes the light flash by sending in sequence recall min/max
commands.

Temporary mode

The Temporary mode is automatically activated when you access the DALI-2 programming window. This
functionality locks the reception of commands coming from programmed functions, by giving priority to actions
executed within the DALI-2 window.

Command Description
Reload temporary Reloads the temporary mode timer.
mode timer

Exit temporary mode Deactivates the temporary mode (control gears are driven by the functions
in the configuration).

Update remaining Retrieves the value of the temporary mode timer.
timer

Control gear commands

After selecting a row from the Control gears table, you can send one of the commands described in the following
table:

Command Description
Read control gear Reads all the settings/parameters saved in the control gear memory.
settings
Write control gear Writes new settings in the control gear memory.
settings Note: the software will notify the pending change by placing warning icons next
to the modified fields.
Reset control gear Resets the control gear settings
settings
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Command Description

Update control gear Updates the information inside the control gears table with the status
status

Undo changes Deletes pending changes from the selected control gear

Control device commands

After selecting a row from the Control devices table, you can send one of the commands described in the
following table:

Command Description
Apply predefined Applies the default values compatible with the Light function managed by
settings UwpP
Read control device Reads all the settings/parameters saved in the control device memory.
settings
Write control device Writes new settings in the control device memory.
settings Note: the software will notify the pending change by placing warning icons next
to the modified fields.
Reset control device Resets the control device settings
settings
Undo changes Deletes pending modifications from the selected control device

DALI-2 instances

Overview

Instances are used for integration in systems with a DALI-2 central control unit.
Each input device functionality can be a device instance itself.
Examples:

o A DALI-2 switch has 4 push buttons. Each of them would be an instance (with type: pushbutton).

o DALI-2 Combi Sensor Module has the following sensors: light sensor, motion sensor, temperature
sensor, etc. Each of them would be an instance of the module.

There are different DALI -2 Instance types available (specified in the DALI-2 standard):
« Instance Type 1: push button (62386301)

« Instance Type 2: analogue input (62386302), used for all other inputs such as sliders, rotary buttons,
temperature sensors, humidity sensors, air pressure sensors, air quality sensors, etc.

« Instance Type 3: motion detection measurement, i.e., PIR (62386-303)

« Instance Type 4: light intensity measurement (62386-304)

Functionality

DALI-2 input devices in instance mode do not send DALI control commands. The higher-level control units
process the status of each instance in the system and send the necessary DALI control commands.

Each control device push button or any other input method (such as push button, rotary button, etc.) and each
detectable sensor value (such as motion, light, temperature, etc.) is a separate DALI-2 instance of the DALI-2
input device.

Go to the next section to find details about the configuration options.
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Instance settings: general

Notice: each instance can be configured individually.
The table below describes settings valid for all types of instance.

Instance T
e Description

Enable / Enables/Disables instances.

Disable Note: if instances are not mandatory, they can be deactivated. In this case, event messages
are not sent, and the measured values are not updated. However, they can still be requested
via a “Query” command, and the DALI-2 configuration commands/queries can still be
supported.

Event It determines what information is transferred with the event. This information permits

Scheme enabling the recognition and/or filtering the events on the DALI bus.

The following five options are available:

« Instance addressing

« Device addressing

» Device/lnstance addressing

Note: this option must be set so that UWP can properly manage the instance.

» Device group addressing

« Instance group addressing
Instance There are 32 instance groups available: each instance of an input device can be
group assigned to up to three instance groups.

Notes:

. the "primary group” is used for the event

. the instances of different input devices can be assigned to the same instance group .

Instance It defines the DALI-2 standard valid for the relevant instance.

type The different instance types are specified in the DALI-2 standard and each input

device can include up to 32 different instance types.

Inntfr:?t:‘:f It is unique for each instance in a device and is assigned by the manufacturer.

Device The device can be assigned to up to 32 device groups (0...31).

group Note: the lowest Device group is used for the event.

g:citégl After the DALI addressing, each device gets a DALI address.

Note: input devices have a DALI-2 control address 02..632. With this address the device can
address be clearly addressed. If needed, a different device add, be assigned.

(SA) e clearly aadressed. It needeaq, a di erent device address can be assigned.

Event Important: only for instance types 2, 3 and 4.

Priority The Event priority determines the order in which events are sent when they occur
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Instance
setting

Description

<

Dead Timer

Report
Timer

Hysteresis

Minimum
Hysteresis

Hold timer

29

Important: it can be set for each instance but only types 2, 3 and 4.
The Dead timer:

» determines the time that must pass before an event can be sent again.
» applies if the event information (e.g., measured value) changes.
Note: if no dead timer is required, it can be deactivated.
Important: it can be set for each instance but only types 2, 3 and 4.
The Report timer:
« allows the value to be sent as a DALI-2 event regardless of the value changing.

o determines the maximum time between an event sending and its resending.

» schedules the cyclic event sending.

Important: it can be set for each instance but only types 3 and 4.
Hysteresis can be used to set the percentage of change necessary to trigger a new
transmission.

Note: not all changes in value lead to the generation of an event.

Important: it can be set for each instance but only types 3 and 4.
It is the minimum value below which it is not possible to go.

Itis the time interval before the status People in the room and no movement
changes to Empty room. If movement is detected during this interval, the status
changes to: People in the room and movement.
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Procedures

Add the DALI-2 Gateway by using automatic discovery

Note: an important prerequisite for managing the automatic discovery is that the UWP’s serial port COM1 is not already in use.

The project loaded in UWP must not have Modbus server and/or client functions active.

1. From the Module manager window, select Discovery > DALI-2 gateway discovery (see the picture

below).

Module manager

B R E B ee ()

Hoeme Save and Emergy Building ﬁtﬂuq R5485 R5485 Seral tolP
Home COM1 COM2 converter=

%B HSBUS full descovery

Templates  Discowered  DF

@ Q ES HSBUS quick discoveny

Part Mumber | SinOb.) .
fﬂ DALLR gateway discovery

Note: the DALI-2 devices connected to the COM1 will be available in the left tab (see the picture below).

Module manager

QERME B @8 (& |

Home Save and Energy Budding  Discovery RS485 RS4BS Senal to P

Hame - COMT COM2 comverter™ gant
Discovery Add subnet
Templates Discovred
(&
Part Number SinClbject FueRery Sate
B oumceoze 10002249 0 AddedOk

2. CIick@ to add the DALI-2 module to the project (see the picture below).

Module manager

GEME B @8 {3

Home Sawve and Energy Building I}-sl:l:ﬂvrrg,I R5485 R5485 SenaltolP
Discovery Add subnet

Hame COM1 COM2 corverter™ gen

It will appear in the Modules networks tab in the middle (see the picture below).
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S& 8 B B KK

R5485 R5485 Serial to IP Bus DALlI-2 | LoRa Excel
COM1 COMZ converter~ generators™ Gateway File =
Add subnet Import

I Modules networks I

g 2 Q 2

How to add manually a DALI-2 gateway
1. From the Module manager window, select DALI-2 gateway (see the picture below).

Module manager

CEMEH B3 &8 3 B |&

Home Sawve and Energy Building Discowery RS5485 RS485 Senalto IP Bus DaLl-2
Home b COM1 COM2 converter™ generators ™ |Gateway|
Discovery Add subnet
Templates  Discovered DALI-2 Modules nety

The DALI-2 device will be added to the Modules networks tab in the middle (see the picture below).

SE 3 B B KK

R5485 RS5485 Serial to IP Bus DALI-2 | LoRa Excel
COM1 COM2 converter* generators™ Gateway File =
Add subnet Import

I Modules networks I

g 2Q v,

2. Click the device added to the Module networks tab.
3. Inthe Objecttab > SIN address field, enter the SIN code.

How to apply same settings to multiple control gear/device signals

Note: an important prerequisite for managing the multi-editing is to keep the Drag-and-drop option disabled (see the picture
below).

Modules networks ~ DALI-2

A

5 2o
9_‘?‘3 @ N[:m ..... —— :
v 0 Control gear otreserved ¥ 0 W m
w 1 Control gear otreserved * 1 v u_ﬁ
v 2 Controlgear  otreserved > 2 v o

1. From the Module networks tab, click on the DALI-2 gateway module.
2. After you have selected the DALI-2 gateway, click the DALI-2 tab to access the signal list.

3. If you want to apply the same changes to more control gears/devices, check the first column to mark the
signal(s) to be edited (see the picture below).

Making changes to the signals: the software will notify the pending change by placing warning icons A next to the
modified fields.

4. Write the notifications in the devices from Control gear commands > Write control gear settings (only
for the selected rows).
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5. Save and exit.
Note: if you change the signals name only, you can skip the step 5.

Offline project, add a control gear and match it with automatic discovery

1. Click 'g @(Add control gear(s)) and set the number of devices to be added to the DALI-2 gateway.
Note: the number of devices must match the number of devices that will be physically connected to the gateway.

2. Click Add selected control gear(s) to add the devices to the DALI-2 gateway.

3. After you have added the devices to the list, from the Offline configuration column select Reserved and the
type of device to be installed.

For example: if you install control gears - type 8, you must select Reserved (type 8).
4. Click Save and home.

Compile and save the project.
After compiling, the signals created in steps 2 and 3 will be available for the project functions.

6. Create the Light functions and save the offline project (after compiling).

7. After you have connected the control gears to the DALI-2 gateway, load the project saved in step 7 and go back
to the DALI-2 gateway signals.

8. From Control gears and device commands, select Initialise all devices and wait for the field devices table
to be filled in with the values read from the field.

9. Select Link all projects signals to field devices to connect the signals used by the functions to the physical
field devices.

10. Click Save and home.

11. Compile and write the project in the UWP.

Offline project, add a control device and match it with automatic discovery

é
1. Click -I?@ (Add control device(s)) and set the number of devices to be added to the DALI-2 gateway.
Note: the number of devices must match the number of devices that will be physically connected to the gateway.

2. Click Add selected control device(s) to add the devices to the DALI-2 gateway.

3. Select the control device and click =P (Add control device(s)) to select the number/type of instance that
the control device will manage (see the picture below).

Add control device instancels) manualty (%)

Rlect fram tn 0 L@

4. Select the control device to open the relevant added instances and check the Enable box (see the picture
below).

Note: this field is important to ensure that the system considers the instance.
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Meodules networks — DALI-2

YRR

Index Name Offiine configuration | SA& | Link || Type  Phymin

Click Save and home.
After compiling the project, the signals created in steps 2, 3 and 4 will be available for the project functions.

Create the Light functions and save the offline project (after compiling).

© N o o

After you have connected the control gears to the DALI-2 gateway, load the project saved in step 7 and go back
to the DALI-2 gateway signals.

9. From Control gears and device commands, select Initialise all devices and wait for the field devices table
to be filled in with the values read from the field (see the picture below).

10. Select the device added in step 4 and click Apply the current selected temporary device to the current
selected project device (see the picture below).

11. Click Save and home.

12. Compile and write the project in the UWP.

How to replace a DALI-2 master
This procedure describes how to replace a faulty DALI-2 master on a configured DALI network.

Replace the faulty DALI-2 master with the new one by taking note of the new installed device SIN.
Discover all the DALI-2 modules and search for the new connected DALI-2 master SIN.

Access the Module manager, select the faulty DALI-2 master and replace the SIN with the new one’s.
Click the DALI-2 tab and read the information from the DALI network (Command > Read all devices).
Save and exit the Module manager.

Compile the project.

Download it.

Nogokhwh=

How to replace a control gear

1. From the DALI-2 window, select the control gear to be deleted and click Delete control gear SA from the
Control gear tab.

Note: the control gear to be replaced will be deleted from the table.

2. Replace the field device.

3. From the Control gear and device commands tab, click Initialize new devicesand wait for the devices to be
updated.

Notes:
o the new device will be added to the list with the first available SA that should match the previous one.

o if you skip the step 1, a new SA will be assigned in the step 3.
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o the previous device row will be in error because of missing responses so you will have to delete it (Delete SA).

. if the network has already 64 devices, you must first delete the existing device row.

How to identify a control gear (new project)

1. From DALI-2 > Control gear and device commands, click Initialize all devices and wait for the devices to
appear.

2. Switch off all ballasts using the OFF command in broadcast.

Click the first row from the control gears table and select Identify to make the field light flash.

Modules nctwerks  DALIZ

sosoaosa A

4. After identifying the light, check the Link column to assign the field signal to the project signals and to modify
the project name.

Modules networks DALI-2

0290

Index MName Offline configurati... SA Link

b 0] Customer service office Mot reserved ~

ol gear Not reserved +

5. Repeat steps 3 and 4 for all lamps.
6. Save and home.

7. Compile the project.

How to add new control gears to an existing project

From DALI-2 > Control gear and device commands, click Initialize new devices and wait for the new devices
to appear.
Note: the system will assign the new SA starting from the first available.

How to resolve conflicts by changing manually the SA

A conflict occurs among devices if they have the same SA and if you connect to the DALI network devices that had
already been initialised or if you change a device SA manually.

You can remove or change a short address* using the devices Random address command.
*Note: the gateway only knows the SA of devices present in the table before the conflict.
To solve this issue, you have to:

1. Delete the device SA (Delete control gear command).

Note: only the SA of the control gear in the table will be removed, not the SA of the control gear added later.
2. Read the devices (Read all devices command).

Note: after the reading, only the added device will appear in the table.
3. Initialise the devices without SA (Initialize new devices command).

Note: a new valid SA will be assigned to the device whose SA has been removed (see step 1).
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> Procedures v
Content
This chapter includes the following sections:
Module manager MENUS ... . 36
DriVer MaNag Mt 39
62

Procedures
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¥ > Module manager menus

Module manager menus

Module manager

- A Bl
RERME B2 40 &|kK
Home Save and Energy Building Discovery | RS485 RS485 Serial to IP Bus DALI-2 LoRa Excel

ome - COM1 COM2 converter™ generators™ Gateway File™
Discovery Add subnet Import 1

Templates Discovered DALI-2 Modules networks @ Logs Locations Object IE
A EYF) 8 9Q @ 4 LR e [ &

Name Ver Path Ref Name Parthumber Log Time Type Mets
3 Modbus RTU
3 Modbus TCP
3 Smart-Dupline
» Wireless. C

Element Description
You can select the type of discovery:
%8 o HS bus full discovery
. HS bus quick discove
Discovery g Y
o DALI-2 gateway discovery
A Adds subnets
B Import options.

See Import module list from Template file
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> Module manager menus

Element Description

From this area you can manage the modules discovered, the drivers and the DALI-2
modules. Three tabs compose it:

Tab Description

Module filter, opens the Filter options table.

) gNew driver
) }-Blmport driver
) DCopy driver

’ 9
T |
emplates Export driver

Modules. From each product category you can select (@) one
or more (you can set the quantity) devices to be added to your
configuration. You can also see the activation status:

AN
Activated and in use
Activated but not in use

Discovered Shows the modules discovered
DALI-2 Shows the DALI-2 modules discovered

Shows the modules and the drivers (if available). Three tabs compose this area,
depending on the modules you select:

Tab Description

EIClone

@Apply selected location
Apply highlighted location
% Set log configuration

%% Mark/Remove mark for copying rows

I-_@ Paste properties

@Modbus settings

See Driver management

Modules network

Driver

Driver test
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Element

> Module manager menus

Description

E

This area shows info about the Locations where the modules are added and the
properties of the object you select.
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> Driver management

Driver management

<

In the Module manager window, you can manage the Modbus TCP and RTU devices and the relevant drivers.

Thanks to the driver management functions, you can:

« Develop Modbus drivers to communicate with Modbus devices (Energy meters, energy analysers, etc..) in

reading and writing modes

« Connect Modbus devices (meters, analysers, environmental sensors, etcetera.) either via RS485 or

Ethernet
» Gather data from devices according to their Modbus protocol.

User interface
You can manage your drivers from the following IDE areas:

Tab Description
Templates Module manages This tab shows the list of the

Q @ available Modbus drivers for

o= = = Modbus RTU and Modbus TCP
T Home o devices. The official drivers are

shown for the available Carlo
Templates | Discovered Dl Gavazzi meters, analysers and
& 00 environmental sensors. You can
Mame = find custom drivers in the User

' Meodbus RTU space folder for both RTU and
v Modbus TCP TCP connections.

¥ Smart-Dupline

1. Templates tab

Module manager

CENE B & (&

Home Save and Energy Building Discovery RS485 RS485 Serial to IP
Home - COM1 COM2 converter¥

Discovery Add sul

Templates  Discovered DALI-2

=) :
R 2 PQ
Name = Ver

4 Medbus RTU

» Environmental senso
3 Meters and analysers

4 Userspace

4 Driver test
Default1

e
Yy
(=]
=

2. User space for RTU connection
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Tab

Description

> Driver management

Driver (in the
central area)

Module manager

QE]II

Home "-a e ard Energy Buidding :s
Templstes  Discowvered DALL-2
& (3 [
MName =
a Modbus RTU
] Emvvironmeental senso
¥ Meters and analysen
& Lserspace
a Drrrveer best
Default]
¥ Modbus TCR
It shows:
a.
(see Driver tab).
b.

‘L@@Q

'
E\-&

‘\.E i*'a Bus
COMmETtEr™ generstons ™

ery ddd sab

3. Driver tab

you select (see the picture below).

Modubes networks  Dviver
E N, 4
MNa
o D test
4 Default]
L3 EE Detault Gasup
Notes:

w2 Q

War name | Address
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It appears only if you select or scan a Modbus TCP and/or a RTU device or if you
create orimport a driver.

Da&Ll-2 ofa
Gabeway

2 28

the inner hierarchy of a device Modbus driver and the relevant parameters

a panel on the right containing the parameters according to the driver level

Desonption

Driver name test

Lirner Cal .:'E oy

ST P
RTU data format o
Baud rate =
Panity =
Clata bets =

the access to the different tabs depends on the Modbus driver status.

ifthe driver is an original one, you can only see it in Reading mode.
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> Driver management =2
Tab Description
Driver test (in the It only appears if a driver has been configured, saved and built.
central area) Shows the options to execute the Driver test, that is:
Modules networks Driver
= IERY

h \ar name
F] D 2 est 3
i Defaultl

4 #= Default Groupl
E Cantral variables ’ 1
T, Ah(+)TOT Ah
A Ahn (JTOT Ahn
rx-l"‘: Ahnpar (-JPARTIAL Ahnpar
Driver test options

1. setthe Control variables according to the needs
2. save
3. build

Note: the Driver test label will be available.

In the areas described above, you can also sort or filter the available Modbus drivers (see the picture below).

Templates ~ HSBUS DALIZ —
@LGARD w2 2Q

-

Name
Fl Madbus RTU =

4. Search bar

NV
You can then sort the results in ascending or descending ( / ) order clicking the column titles.

You can also access the advanced filter options ( ? ), available in each column title, or Clear them (see the
picture below).
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¥ > Driver management

Nam:h‘ - ¥ [(1a! I
Fitter Rules I :
Modbus TCFl__
Meters and |

, EM24-DIN.E {AID (14 —

| 3ps31p 1P/3.1P
L 2P
P
2P
| B
| P3P EbLES
Modbus RTL EM24-DIM.ET
Meters and | Meters and analysers
1 emoa Medbus RTU
| e Madbus TCP -
ElER S

Templates tab
Note: the list may vary according to the UWP IDE release.

Templates Discovered DALI-2
dLRD " 0 9 Q

| -

Name o Ver
3 Maodbus RTU
3 Maodbus TCP
3 Srnart-Dupline
3 Wireless

5. Templates tab commands (see the table below)

&2:22% Description Notes
Creates a driver that will be added to the User space folder. Always available,
independently from where

the user right-clicks.

Imports a driver (XML format) generated by the UWP 3.0
Tool, UWP IDE, the UCS or DUG software.

Creates a copy of an existing driver. Available only if a driver in
Note- Carlo G  dri d edit it the user space folder is
ote. you can copy a Carlo Gavazzi ariver ana edit It. selected.
Exports a driver in XML format. Once exported, you can
E import the file into another UWP 3.0 Tool, UWP IDE or into the
UCS software.
Deletes a driver from the list. You cannot delete the
@' Carlo Gavazzi locked
drivers.

The following fields compose each Modbus driver:
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> Driver management

Field name Description

Name The device name (i.e., the part number) to which the Driver is associated.

You can add (@) options to view the available devices to the configuration.
Status icon  The Driver status:

Icon Status Description

Editing The driver is being edited, but it has not been successfully
compiled.

to be be tested. It is not available for connecting Modbus devices to

3 Build OK, The driver has been successfully compiled and is available to
e activated | the UWP 4.0 controller.

Activated  The driver has been successfully compiled and activated. Itis
2 butnotin  available for connecting Modbus devices to the UWP 4.0
use controller.

Activated  The driver has been successfully compiled and activated. Itis
2 andin use available for connecting Modbus devices to the UWP 4.0
controller.

Ver Shows the Driver version of the relevant part number

Driver tab: edit function

From the Driver tab, you can open the edit options to create and modify one of the available Modbus drivers
(see the picture below).

Modules networks Driver

Ql? Only Read mode

Edit driver I Name

6. Edit function

Note: you can perform these actions only for drivers that belong to the User space folder (see User interface).

As soon as you click @ , the following toolbar and details appear (see the table for the description):
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> Driver management

<

%, a an o Haolding Registers [d03) = WTE2[w] =  HecNE Dec R =
% aLz iz o Holding Regters [0 = T W] v Hee [NE O N -
A % am &3 o Folding Registers (W03 = WTEZ[w] = Hec A0 DecOTE =
[ 7E Bun hour meter Heur o Halding Regrters (n03) = WTEE[BwW] * Hee|SA Dec@g
[ % b He o Halding eginters (03} = UINTIG[ta] =  Hex[00EE Dec0081 =
l_]':ﬂ;w.ﬁ.m Vidmd o Haoldeng Regaters [Dd03) = INTEE [2w] = Hee | TH Dec 118 %
[ % wvals KA o Halding Regiters ([D03) = WTEe] = Hex [E  Dec 0 &
% a2 AL o Haolding Pegisters (D03) = wWrzpw] » Hee AN Dec NS X
[ % wwals KAz o Halding Regrters [0n03) = W2 Rw] = HecHE oec G 2
1% s Ko o Haoiding Registers (203) + T3] v Hee [N Dec A I
[ %, wartt kvarll o Halding Regiters (03] = WiEzfe] » Hex AR Dec 0G0 &
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> Driver management

Area Description

A Contains the edit toolbar and the hierarchical driver structure.
The toolbar permits you to do as follows:

Icon Description

Deletes the selected items

Eb

o Deletes the driver the device is designed for

Creates a new blank group

Creates a new variable to the selected group
Creates a new control variable to the selected group
Copies the selected items

Saves the changes

Builds the driver before using it in the configuration

Activates the driver before using it in the configuration

@O MNS il

The driver levels are the following:

Level

Description
DRIVER A Root Iev_el where you can define the parameters of the field bus
connection.
DEVICE B Any pattern considered as a group of variables that identifies a
specific operation mode of the target Modbus device.
Any group of variables connected through a logical link.
GROUP C Note: in the case of multi-meters, any single meter is considered as a

group.
Any single variable in a group.

VARIABLE D Here you can define the Modbus register settings, scales, ranges
and validation rules.

B Shows the parameters according to your selection.

Example of a Modbus driver hierarchy
The example below shows the hierarchy of a Modbus driver and the parent-child relationship:
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EM24-DIN..E1 Copy

Group3P-1
Control variables
ALl

AlL2

AL3

Run hour meter
Hz

kVA dmd

kVA L1

kVA L2

kVA L3

Each level has a specific set of parameters that you have to provide according to the Modbus register map.

According to the selected level, the available options change. Please consider the following table:

> Driver management

Option Description on‘f’Ii;sg:"ty
Build Always available A/B/C/D
Test Tests a driver but only after a valid compilation. Go to the Test drivertab | A/B/C/D
Add Adds a configuration for the Modbus device A
device
Add group Adds a group for the selected device, that represents a Load of the B
Modbus device (e.g., Energy Meter)
Add Adds a variable for the selected Group C
variable
Delete Deletes the selected level. B/C/D
selection Note: this operation affects also the sub-levels in the main level.
Copy Copies the selected level and the entire hierarchy B
device
Copy Copies the selected level and the entire hierarchy C
group
Save Saves all the changes and parameters. A/B/C/D

Driver tab: communication parameters

Note: the rollover command is no longer available so you can close the window
without saving the pending changes.

From the Driver tab, if you select the very first driver level, the following parameters panel appears on the right:
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Description =

Ak 4F

Frame max. dimension [wond

&
4 4F [ 4

7. Communication parameters

N.B.: not all the parameters are needed. Please refer to the Modbus register map of the device.
The following table describes the communication parameters above:

TCP

Parameter Description IRTU

Driver name Identifies the device in the list. Both

Driver version | Automatically updated whenever a change is applied or you
can change it manually.

Driver brand Identifies the device manufacturer in the list.

Driver Identifies the type of driver.
category Note: if you click the Device type, you group the drivers by type.
Driver port The communication port (RTU for Modbus RTU

communication via RS485 port or TCP for Modbus TCP/IP
communication via Ethernet port).

Note: you cannot change it since it depends on what you select at
the driver creation. So, if the selection is wrong, the only way to
change it is to create the driver from the beginning.

RTU data format
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Parameter Description I-II:':I'TJ
Baud rate Range of allowed baud rate values
Type Default Values
int16 7 [9600bps] 0 110
1 150
2 300
3 600
4 1200
5 2400
6 4800
7 9600
8 19200
9 38400
10 57600
11 115200
12 256000
Parity Range of allowed parity RTU
Data bits Range of allowed data bits RTU
Stop bits Range of allowed stop bits RTU
Default port For each port, you can select the default communication RTU

configuration  value that will be shown during the device configuration.

Slave min./max. limits

Slave min. Minimum value available for Modbus addresses. Both
address Note: some Modbus devices accept a restricted set of addresses.
Slave max. Maximum value available for Modbus addresses.
address Note: some Modbus devices accept a restricted set of addresses.
Timings

Interframe Time interval between two Modbus frame readings. Both
Rate (ms) Note: 10 ms is the default value that corresponds to standard 3.5

chars.
Frame The maximum time interval during which a response to a Both
response command (set in the target Modbus slave) is expected.
timeout Note: 500 ms is the default value.

UWP IDE | User manual v. 5.0 13/11/2023| | © 2023 CARLO GAVAZZ| Controls SpA 48



> Driver management

o TCP
Parameter Description IRTU
Delay before  The software provides an explanatory diagram illustrating the Both
frame retry meaning of the parameter
Delay on Both
slave change
(ms)
TCP timeout TCP
TCP TCP
reconnection
Frame rules
Frame max. The number of words identifying the frame size. Both
dimension Note: according to this value, the tool splits the map into frames.
(word)
Enable multi- Disabled by default. Both
group frame vy can group according to the other parameters.
Number of If the master interrogates the device but an error occurs, you
retries can set the maximum number of attempts.
Address Defines the variable register size: 1 Byte or 1 Word (default Both
mapping value)
mode

Driver tab: device level

Devices are different working modes in the same Modbus device.

Note: some meters may have different working modes, which allow them to work in 3-phase or 1-phase systems. For this
reason, a Modbus driver of a Modbus device may contain different devices/applications.

You can add, edit and delete a configuration by using the available commands in the Edit mode.
Whenever you select a device level, you can only change the device name (see the picture below).

- [}  EM24-DIN.E1 Copy Copy
B L
k EE Group3P-1

8. Device name

Driver tab: group level

When you create a driver, it will be empty and will contain only a variable control group that you cannot delete because
otherwise you cannot re-add it but you can check if you can add / remove the control variable group.

Groups are set of variables belonging to the same configuration. Some devices may have different groups in the
same device/application, usually corresponding to a sub-meter. In this section, you can add, edit, save and delete
a Group.

To add a group, click ® =® . Once you have added one, you can edit the right panel parameters (see the picture
and table below):
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Description

Edit or select name

Enable group by default

Set as template group
Temnplate based on an offset

Ternplate offsat

Skip missing addresses i frames

Electric phase group

Fuxed phase group
Free phase
Linked phase

O T
Letault phase

Default Group1

Frarmes [calculated after driver building)

Frame = Phase

Parameter

Priority = Address | Length Type ‘Variables

9. Right panel parameters

Description

-

W

> Driver management

Edit or select name

Enable group by default

Set as template group

Template based on an offset

Identifies the group in the relevant configuration.

Shows if the group has been enabled after adding the

device.

Sets a template for the slave addresses or for

addressing individual signals.

Sets a template for signal addresses that considers an

offset specified in the following label.
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<

Parameter Description
Template offset Itis available only ifthe Set as a template group
parameter is enabled.

You can set the offset (see the picture and the
procedure below):

Modules networks Driver Driver Test

% = 0B PR @
U m R Q Description -
4 Name S -
. (I} generico2 Edit or select name Defsult Group1
- Default1 Enable group by default
o
- $=  Default Groupl 1 Setas template group

2= Control variables

2 Template based on an offset
o Generic 01

ar L] k] R] e

3 Template offset 10

Enable the group as a template

Select this check box to be able to set the offset
Set the offset

Save the driver

Build the driver

. Activate the driver

Select and add the driver to the configuration (see
the picture below)

4 generico2 \}‘ 0.2 7
Default1 1 :@3

8. Clicking on this icon, you can create another group
based on the first you set as a template.

NoorwN

9. Here you can calculate the offset set in this group.

Note: the number indicated in this column is multiplied
for the offset we decided at the point 3.

Considering the picture below:

the first group offset will be

1*10=10

the second group offset will be

2*10=20

the third group offset will be

3*10=30

Therefore, if in the original group taken as template a

variable had address 100, in the created offset groups, it
will have address 110, 120, 130 respectively.

‘ [

&, L1 Default
4 i} L1 Default
[Vj L1 Default generico2 De... 8
4 :r‘mg I ~ L1 Default generico2 De... @I
rVJ L1 Default generico2 De...
4 o V] L1 Default generico2 De... | [ 1
‘7, L1 Default generico2 De...
4 @ v| L1 Default generico? De... | [ > b9
‘v, L1 Default generico2 De...
y o> v| L1 Default generico? De... | [ 3+
Skip missing addresses in frames It does not include not declared registers during the

frame creation.
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Parameter Description

Electric Phase Group

Fixed phase group For standard 1-phase energy meters or power
analysers that have to be linked to a specific phase
during the set-up process; the phase is defined at the
configuration level.

Free phase For standard 1-phase energy meters or power
analysers that must be linked to a specific phase
during the set-up process; the phase is defined at the
group level.

Linked phase For standard 1-phase energy meters or power
analysers linked to a specific phase (L1, L2 or L3).

Frames (calculated after driver building)
Frames (calculated after driver building) <

Frame =« Phase Priority | Address | Length Type Variables

Driver tab: variable level

In this section, you can add/edit/save/delete a variable (always contained in a group). A predefined set of
variables is automatically created according to the Group Type (see picture below).

i~

.o iz -
1 e an o Hoddenqy Riegrrters [all3} = MTIZ [2wl =
e - T Wl ™ Mo mappang =
e -
T = .
e " - - s § =
- e - o]
o e - wl
- . . Raw duta pwaping - |A)EECHD] o
s -
s ” - 5
Fa i - "
. R - wl
. Duitis ity =
# .-\.
I e v Jord) Bagprient [Ow - T W) Chick ety Befors icaling =
I, ba .
s - g
e Ee - =
Sk « F - i
Wk W s "l
- ol Sawing o :
I i - W -
I - -
I - =

If you select a variable (1), the following parameters open (2):
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Parameter Description
Variable Information about the selected variable. It allows to select the desired variable TAG (if
TAG not defined as default)
Variable Defines the Data Type of the target variable, as shown in the Modbus map
type
Edit or Shows the variable name.
select You can fill itin manually only for a Generic variable. Otherwise, the value is
name automatically set according to the Group (Load).
Map/twin You can associate a signal to another signal. This will be considered a copy of the
mode reference signal. When the reference signal changes, the linked signal will automatically
change too. The label can be changed individually.
Modbus The data types for Modbus are divided into variables that monitor, control, and carry out
function other functions.
Note: see the Modbus protocol documentation of the Modbus device that matches each logical
code.
Function code Description
Read coil Status (0x01) The UWP 4.0 reads the Coils using Modbus function
01
Read/Write coil Status (0x01) The UWP 4.0 reads/writes the Coils using Modbus
function 01
Read Input Status (0x02) The UWP 4.0 reads the Register using Modbus
function 02
Holding Register (0x03) The UWP 4.0 reads the Register using Modbus
function 03
Read/Write Holding Register The UWP 4.0 reads/writes the Register using Modbus
(0x03) function 03
Input register (0x04) The UWP 4.0 reads the Register using Modbus
function 04
Read SD2DUG24 (0x64) The UWP 4.0 reads the SD2DUG24 addresses using
FC 64
Write/Read SD2DUG24 The UWP 4.0 reads/writes the SD2DUG24 addresses
(Ox64) using FC 64
Data Check the Bit description in the Raw Data Swapping sections below.
Format
Starting It defines the Initial hex address of the target variable, as shown in the Modbus map.
Address
Enable Flag it to enable the State mode and manage all signals that can be used as Multi-state
State Mode signals, assigning a label to every value the signal can assume.
Enable Bit Flag it to enable the Bit mode and manage all signals where a single bit can assume a
Mode specific meaning, assigning a label to every needed bit.
Raw Data Swapping - - > [A][B ]
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Swap conversion: an operation that converts the Modbus address. Depending on the selected data

> Driver management

type, it allows to properly order all the data bytes of the frame and read the data.

Request Frame

[01h][03h][00h][00h][00K][02h][C4h][0Bh]

Reply Frame [01h][03h][04h][08h][FCh][12h][00h][38h][63h]
Data Bytes [08h][FCh][12h][00h]
l
[A1[B][C] [D]
Bit Description
16 SWAP16 can be used to swap the nibbles of a byte:
[B][A] [D][C] > [FCh] [08h] [00h] [12h]
32 SWAP32 can be used to swap bytes of a Word:
[CI[D] [Al[B] > [12h] [00h] [08h] [FCh]
64 In the case of registers that are 4-word long, also the

SWAP 64 can be used:
[AI[B] [CI[D] [E][F] [G][H]
[GI[H] [E][F] [C][D] [A][B]

Data conversion
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From the Data conversion menu you can set the parameters to apply mathematical operations to
the target variable.

Three sub-menus compose it:

1. Check limits before scaling. In this menu, you can enter the value to reject invalid read values.
This operation can be done before and/or after having read the registers that contain the raw

values.
Invalid value Special decimal value indicating invalid reading
Underflow Special decimal value indicating Underflow
Overflow Special decimal value indicating Overflow
Rollover Decimal value indicating Rollover value

2. Scaling formula*. Here you can enter the value to reject invalid read values. This operation can
be done before and/or after reading the registers that contain the raw values. Enter a divisor or
factor to adjust the applied value to the current value (e.g., correct positioning of the decimal
point).

*[(Value + Offsetl) x (M1 x M2) / D1 x D2) x 10"Exp] + Offset2

Offset(1)
Multiplier
Multiplier Scaling formula: it allows to define whatever combination of registers to calculate a
Divisor variable based on different registers (e.g., reading + scaling).

Divisor

Exponent

Offset(2)

3. Check min/max limits. If the read value exceeds these limits, that value will be not considered.

In the Rules sub-menu, the user can enter the value aimed at rejecting invalid read values. This
operation can be done before and/or after reading the registers that contains the raw values.

If VALUE is Operator used to evaluate the condition
To/Than Value to be checked

If VALUE is Operator to evaluate the condition
To/Than Value to be checked

Then convert to Result of the evaluation

Driver Test tab
This tab appears when the driver is built (see the picture below).
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Modules networks  Driver

| Name

> Driver management

: *| Build click o e o
v [ [ isjewrbuiarhb
uuuuuuu ¥ Jpp—
Modules networks Driver Driver Test
A0 e
M= Activate icon Modbus function
v (1 [ iajewrbviarhb
Once you have built the driver, the tab shows what follows:
& — ;
Cretr Frame webection = Chrvet ni=ee aprwtbecathh
‘. . & Fearme to test Framel(] = Diriver vartion i
& Detauht a
Curfwalt Groupi Furmbei af requeits 1 = Dirives brand ELUSTOM
A . ~ Dimer categony Energy metes
Dirmver port Modbays AT
Timaout emaes a
A Adddren eimon i Connection settngs. —
B ! Tett mode G Seowre Bndge {secure) =
B ereoe 8
;“ o B . Test RTLI/TCR with secure biicige -
her grrom g
Trpe TEp AT =
Test Repporae..  Shatus Resparse detais Cpmmersaton fames WP P 1015000
N Requat Pan 4124 5
0 Gme b Responie Senal coMl -
arigkle Addresy Lergsh iweed) Swap type Hex D (zwap] Binary {swaph Pavtwoed G
VLN 0u000 1
WILILE DudD0CTH 1
Evai DMD [ ] 1 C D
WA (DRI CudD0CTH 1
Area Description
A Connection icon.

This connection works only if a password is set (check Connection Settings

> Test RTU/TCP with secure bridge > 74 @

s

Play the test.

Quit the test.

Then the driver hierarchy tree appears.
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Area

Description

57

Frame selection
Frame to test
Number of requests
Request errors
Timeout errors
Address errors
Data errors

CRC errors

Other errors

Response Panel
Test

Response time
Status

Response details

communication frames

Variable Information

Number of frames requested

Number of requests

Number of Timeout errors
Number of Address errors
Number of Data errors
Number of CRC errors

Number of other errors

In the previous section, you can set the number of
tests to perform.

In this box, all the tests are listed and numbered.
The test response time.

Icon that confirms if the test was successful or not.
The request the system sent to test the driver

The response you received back

All the information related to the variable we are
testing

UWP IDE | User manual v. 5.0 | 13/11/2023 | UWP IDE | © 2023 CARLO GAVAZZ] Controls SpA



Area Description

> Driver management

D Description

Driver Name  Identifies the device.

Driver Automatically updated whenever a change is applied or you can

Version change it manually.
Driver Brand | Identifies the device manufacturer in the list.

Driver Identifies at a glance the type of driver.
Category

Driver Port The communication port (RTU for Modbus RTU communication via
RS485 port or TCP for Modbus TCP/IP communication via Ethernet

port).
Connection Settings
Test Mode « RTUPC COM

« TCPIP

« UWP Gateway (unsecure)

e CG Secure Bridge (unsecure)
Test RTU/TCP with secure bridge

Type Type of connection TCP/RTU

UWP IP IP of the UWP

Port Port selected for the connection
Serial COM1/COM2

Password Web app password — Secure bridge

Baud Rate Transmission speed

Data Bits Range of allowed data bits

Parity Range of allowed parity

Stop Bit Range of allowed stop bits

Communication parameters

Modbus Modbus address of the driver you are testing
Address

Timeout Maximum response time from a slave
Interframe Time between two consecutive frame requests.
rate (ms)

Things to know

Modbus Data Types

The identification of the data type is necessary to develop the Modbus driver. Depending on the device

documentation, the data type may be determined according to any of the above criteria.

The variables are represented by integers or floating numbers, with 2 complement notations in case of “signed”

format. See the following table:
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Type Format Description Bits Range
INT16 Integer 16 -32768 .. 32767
UINT16 Unsigned integer 16 0..65535
INT32 Double integer 32 -231..231
UINT32 Unsigned double integer 32 0..232-1
UINT64 Unsigned long integer 64 0..264-1
INT64 Long Integer 64
FLOAT IEEE754 SP Single-precision floating-point 32 -(1+[1 —-2-23])x2127 .. 2128
Hour 32
UByteLow Unsigned Low Byte 8

Note: it will be used the low Byte of the Word
UByteHigh Unsigned High Byte 8

Note: it will be used the high Byte of the Word
ByteLow Unsigned Low Byte 8

Note: it will be used the low Byte of the Word
ByteHigh Unsigned High Byte 8

Note: it will be used the high Byte of the Word
DOUBLE IEEE754 DP Double-precision floating-point 64 2.2e-308 ... 1.79e308

SWAP conversion

The swap is an operation that converts the Modbus address.
Depending on the selected data type, it allows to properly order all the data bytes of the frame to read correctly the

Request frame: [01h] [03h] [00h] [00N] [00h] [02h] [C4h] [0Bh]
Reply frame: [01h] [03h] [04h] [08h] [FCh] [12h] [00h] [38h] [63]
Data bytes: [08h] [FCh] [12h] [00h]

(Al B Y[C [D]

The following table provides different examples of conversion:

Conversion Result

SWAP 16 SWAP16 can be used to swap the nibbles of a byte:
[BI[A] [D][C] > [FCh] [08h] [00h] [12h]

59 UWP IDE | User manual v. 5.0 | 13/11/2023 | UWP IDE | © 2023 CARLO GAVAZZ] Controls SpA



- > Driver management
Conversion Result
SWAP 32 SWAP32 can be used to swap bytes of a Word:

[CI[D] [A][B] > [12h] [00h] [08h] [FCh]

SWAP 16 +32 SWAP16+32 can be combined together:
[D]IC] [BI[A] > [00h] [12h] [FCh] [08h]

SWAP 64 In the case of registers that are 4-word long, also the SWAP 64 can be used:
[AlIB] [C][D] [E][F] [G][H]
[GIH] [E][F] [CIID] [Al[B]

SWAP 16 SWAP16 can be used to swap the nibbles of a byte:
[B][A] [D][C] > [FCh] [08h] [00h] [12h]

Data conversion menu

The Data conversion menu contains the parameters that can be used to apply mathematical operations to the
target variable. It contains three sub-menus: Check limits before scaling, Scaling formula, Check min/max
limits and Rules.

Check limits before scaling

CLla £ ifmntriady

Theck iy Bedore walng =

In this menu, you can enter a value that rejects invalid read data.
This operation can be done before and/or after having read the registers that contain the raw values.

The table below describes each field:

Parameter Description

Before Scaling Invalid value Special decimal value indicating invalid reading

Underflow  Special decimal value indicating Underflow

Overflow Special decimal value indicating Overflow
Rollover Decimal value indicating Rollover value

After Scaling  Min If the read value exceeds these limits, that value will be not considered.
Max
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Scaling formula

Falmg tarmgly =

un et

4k dF 4F A4k dAF AF dF

Scalineg formisla

In the Scaling formula menu, you can enter the value that rejects invalid read data. This operation can be done
before and/or after reading the registers that contain the raw values.

Enter a divisor or factor to adjust the applied value to the current value (e.g., correct positioning of the decimal
point).

The following table describes the Scaling formula:

Parameter Description
Offset1 Scaling formula: it allows to define whatever combination of registers to calculate a
Multiplier ~ Variable on the basis of different registers (e.g., reading + scaling).
Multiplier
Divisor [(Value + Offset1) x (M1 x M2) /D1 x D2) x 10"Exp] + Offset2
Divisor
Exponent
Offset2
Rules
@D
If VALUE is To/Than AND if VALUE is To/Than Then convert to Apply after scaling

In the Rules sub-menu, the user can enter a value that rejects invalid read data. This operation can be done
before and/or after reading the registers that contains the raw values.

The following table describes the Rules parameters:

Rules list List of configured rules
If VALUE is Operator used to evaluate the condition
To/Than Value to be checked
If VALUE is Operator to evaluate the condition
To/Than Value to be checked
Then convert to Result of the evaluation
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Procedures

Content
This section includes the following topics:

Add an energy meter manually . 62
Add I0CatIONS .. 63
Automatically find and add Smart Dupline® modulestoanew project ... 64
Automatically find and add Smart Dupline® modules to an existing project ............................................ 64
Move a Smart Dupline® module froman MCG to another ... ... ... . . . .. 65
Move an energy meter froma COM porttoanother ... ... .. 65
Move an objectto anotherlocation ... . 65
Import module list from Template file ... 65
Create an offline project with Smart Dupline® modules ... 73
Replace a faulty module previously used in the configuration ... .. . 75
Change module NetwWorK . 76
Copy and paste ModUIES . 77
CloNe MOAUIES ... .. o 79
Delete MOAUIES ... . 80
Setthe data logging . ... 81

Add an energy meter manually

1. From the Home menu bar, access the Module manager menu

2. From the Add subnet area, select a serial port (see the picture below).

Module manager

QEME B @& & B & bk

Home Save and Energy Building  Discovery R5485 R5485 Serial to IP Bus DALl-2 | LoRa  Excel
Home - COM1 COM2 converter~ generators™ Gateway File =
Discovery Add subnet Import

Note: if you don't select any serial port, the software assigns the COM1 port.

3. From the Templates tab, select the module you want to add.
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Module manager

OBME 5 88 03

Home Save and Energy Building @ Discovery RS485 R5485 Serial to IP

- COMT1 COMZ converter™
Add subn

Home
Discovery

Templates Discovered DALI-2

@ (3 [Q " 2 2Q

MName Ver
4 Modbus RTU -
4 Meters and analysers
« [ craoso V) 35

QAC 1
Q DC 1

4k 4k
@

®

If you select the added module from Modules networks, on the right panel the relevant properties appear.

logs Locations  Object

Modules networks | Driver  Driver Test
o
% P 8 E8PQ QD
Phase Path Ref Name | Log Global signal properties

T & L1 Carlo gavazzi Controls K5 RS485 1 Modbus master

= Signal TAG Status
v L1 Carlo gavazzi Controls... Status

Default name Status
D Stete list =
& Finvalid null =
€ Enable Log =

4. Click Save and Home

Add locations

From the Home page

1. From the Home page
2. From the Project tree tab, right click an object

3. Click %D Add location same level orl-‘i@ Add location child level

Project tree =~ Controller

ARCA

Ref Mame
0 P -
.1" Add location (same level) b
|"i‘_9 Add location (child level) ¥
ﬁ) Change location image r

y |

4. Click Save and Home

63

UWP IDE | User manual v. 5.0 | 13/11/2023 | UWP IDE | © 2023 CARLO GAVAZZI Controls SpA



> Procedures

From the Module manager
1. From the Home page, access the Module manager menu

2. Gotothe right panel Locations tab

3. Rightclick an object
4. Click %D Add location same level or |-DL@ Add location child level

Logs  Locations Object

Ref Location

F | == = == - =
CE‘-‘ Add location (same level) b
il
1 |'? Add location (child level) L
]:;ﬁ Change location image L

M Delete Location

5. Click Save and Home

Automatically find and add Smart Dupline® modules to a new
project
1. From the Home menu bar, access the Module manager menu

2. From the Discovery menu, select the HSBUS full discovery.
The system automatically finds the MCGs and the connected Dupline® modules

3. From the Discovered tab, click @to add the module(s).

4. Click Save and Home

Automatically find and add Smart Dupline® modules to an
existing project
1. From the Home menu bar, access the Module manager menu

2. From the Discovery menu, select the HSBUS quick discovery.
The system automatically finds the Dupline® modules connected to the existing MCGs.

3. From the Discovered tab, click @to add the module(s).

4. Click Save and Home
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Move a Smart Dupline® module from an MCG to another

From the Home page, access the Module manager menu
From the Modules networks tab, select an object

Drag and drop the selected object to a different Master Channel Generator

Wb o=

Click Save and Home

Move an energy meter from a COM port to another

1. From the Home page, access the Module manager menu
2. From the Modules networks tab, select an object
3. Drag and drop the selected object to a different COM port interface

4. Click Save and Home

Move an object to another location

From the Home page
1. From the Home page

2. From the Project tree tab, select the object to be moved

3. Drag and drop the object to the desired location

From the Module manager
1. From the Home page, access the Module manager menu

2. From the Modules networks tab, flag the object(s) you want to move

3. Select the new location by right-clicking the selected object from the Modules networks tab or from the
Locations tab (right panel)

4. Click@ Apply location on checked modules orAppIy location on selected modules

Import module list from Template file

This functionality permits you to add modules in a faster way, reducing the time of creating the module list and
customizing the module/signal names.

You can execute this following actions:
Download a template file
Import an Excel file

Template file

How to download the Template file
You can override the module, signal and location default names using an Excel file.
Follow this procedure to download the Template file and fill it according to the project requirements.
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1. From Module manager > Import > Excel File, click Get Excel template file
2. Inthe Save As window, choose the target directory to download the template file.

Template file overview

The Template file is an .xIsm document you can edit with Microsoft ® Office 2007 or later.
The example below shows the file structure related to a module.
Note: you can only edit the green cells but not the red ones, otherwise the file will not be imported correctly.

BAleods PartNrumbe SinA SinB  SinC Modu‘leeNam Lo;g:Lon Type # SignaeINam
0020450780001 B4X-LS4-U 002 045 078 In 1
6
In
Out
Dia

Following are the field descriptions:

Field name Description
Bar code It can be scanned or typed manually. The fields such as PartNumber, Sin (A,
B, C) and signals are automatically compiled according to the module
information.
Part Number* It can be entered manually or automatically. The Sin (A, B, C) and signals are

SinA, SinB, SinC*

Module Name

Location path

Type (In, Out, Dia)*
# (Number)*

Signal name

automatically entered according to the module information.
See the table below for the list of modules supported by this function.

These fields are automatically compiled if you scan a valid bar code.

When the Part Number is entered manually, you have tofill in the Sin A, B, C
fields with the module SIN.

You can replace the default name with a custom name.

You can enter a custom location path, using the \ between each nesting
location (e.g. Building\Floor1\ Room1).

Note: the \ is not a valid character for a location name.

These fields are automatically compiled according to the number of signals.
Note: you cannot change them.

You can replace the default name with a custom name.

*These fields are mandatory.

How to find the bar code to enter

You can find the bar code on the product carton-box labels. See the pictures below:
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<4

v SHE5XLS4TH

55x855 Light switch

Temperatnrel Humidity
m 154 111 ooo 086

¥~ 3
< P
SHES5XLS4TH

55x55 Light switch Temperature | Humidity

" lIIIIIl\l\l\\\\\\\\\\\\\\\\\\\\\\\

SE-1701622
Made in Malta
SIN 001.154.111/000.066

List of available modules

The part numbers you will manage in the template file are listed here.
Note: other modules than those listed below will not be recognized and marked as NOT VALID.

Part Number Description
SBB412024 Fire damper I/O module
SBB4120230 Fire damper I/O module
BDB-INCON4-U Decentralised module with 4 contacts inputs
BDB-INCONS8-U Decentralised module with 8 contacts inputs
BDB-IOCP8-U Decentralised module for 4 push buttons and 4 outputs for LED
BDB-IOCP8A-U Decentralised module for 4 push buttons and 4 outputs for LED
BDA-RE13A-U Decentralised relay output
SH2RE16A4 Output relay module with 4 outputs
SH2INDI424 Input module for 4 inputs
B4X-LS4-U Light switch with 4 push buttons and 4 LEDs
B5X-LS4-U Light switch with 4 push buttons and 4 LEDs
SHA4XLS4TH Light switch with 4 push buttons and 4 LEDs with temperature and humidity
SHES5XLS4TH Light switch with 4 push buttons and 4 LEDs with temperature and humidity
SHSQP360L PIR sensor with an integrated Luxmeter

SHPINV2T1P124

SHPOUTV224
SHPINNI2
SHSUTD
SHSUTHD

67

Analogue input module with 2 0-10 V inputs, 1 thermistor input, 1
potentiometer input

Analogue output module with 2 0-10 V outputs
Analogue input module with two configurable Pt1000/Ni1000 inputs
Temperature sensor with display

Temperature and humidity sensor with display
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Part Number Description
SHESXLS2TEMDIS  TEMDIS module with 2 programmable push buttons
SH2SSTRI424 Output relay module with 4 solid state outputs
SH2RE1A424 Output relay module with 4 outputs
SBB4l Fire damper input module
SBB2I Fire damper input module
SBB4120230T Fire damper /O module
SBB412024T Fire damper I/O module
SBB4120230T6 Fire damper I/O module
SBB412024T6 Fire damper I/O module
SBB4120230B Fire damper I/O module
SBB412024B Fire damper I/O module

Compile the Template file with Microsoft Excel

The Template file is a macro-enabled workbook (.xlsm). After the download, open it with Microsoft Office 2007 or
a later version to enable the macro content.

Enable Excel macros

If the @ SECURITY WARNING bar appears, click Enable Content to activate the macro content (red
rectangle below):

I SECURITY WARNING Macros have been disabled. Enable Content
A2 - J
A E C B E
1 |Barcode PartNumber SinA SinB SinC ModuleName
z ]

For more details please go to Enable or disable macros in Office files
There are two ways to compile the template file with modules, as shown in the following pages:

« Automatic insertion with a bar code scanner
« Manual insertion (through a keyboard)

Automatic insertion with a bar code scanner

Use a bar code scanner to fill in the Template file with the module information automatically.
Please refer to the following information:

System requirements

Hardware A bar code scanner

Note: configure the bar code scanner to send only one CRLF or enter a key after the scanning.
Please refer to bar code scanner documentation.

Software  Microsoft ® Excel 2007 or later
Note: the Excel macros must be allowed by security policies.

UWP IDE | User manual v. 5.0 13/11/2023| | © 2023 CARLO GAVAZZ| Controls SpA 68


https://support.microsoft.com/en-us/office/enable-or-disable-macros-in-office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6?ui=en-us&rs=en-us&ad=us

> Procedures b4

1. Open the Template file

The active cell in the Excel workbook is the first one (Bar code).

Barcode PartNumber SinA SinB SinC ModuleName Lo;g:i':)n Type # SignalName

2. Scan a bar code to add it to the relevant cell (see below):

PartNumbe SinA SinB  SinC ModuleNam Location

Barcode r e path

If the bar code is valid, it is recognised and the PartNumber and the Sin cells are filled in with the module
information automatically (green rectangle below):

Type # SignaeINam

Barcode PartNumber SinA SinB SinC ModutlaeNam ';,°;::if Type # Signleam

AAABBBCCCDD | PRTNMB0O0O AAA BBB CCC
EE 1

The Type and # cells are automatically filled in according to the number of signals (blue cells below). The active
cell is moved to the next available cell in the Bar code column automatically (orange cell below):

SignalNam

Barcode PartNumber SinA SinB SinC ModuleNam ~ Locatio .

e n path

AAABBBCCCDD PRTNMB00 AAA BBB CCC
EE 1

3. Fillin fields such as ModuleName, LocationPath and SignalName.
Repeat steps 1-3 for every other module you want to add.
4. From the Excel file, click Save.

The file is now ready to be imported.

Manual insertion without a bar code scanner
You can also fill in the template file manually.
Please refer to the following information and procedure:

System requirements

Hardware Keyboard

Software Microsoft ® Excel 2007 or later
Note: the Excel macros must be allowed by security policies.
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1. Open the Template file.

The active cell in the Excel workbook is the first one (Bar code).

Location

Barcode PartNumber SinA SinB SinC ModuleName path Type # SignalName

2. Enterthe bar code manually.

If the bar code is recognised, the module information will be filled in automatically. Otherwise, select the first valid
PartNumber cell and type the desired module part number.

Note: the part number must be in capital letters (for example, shabxIs4th would not be recognized).

Location

Barcode PartNumber  sinA SinB SinC ModuleName path

PRTNMBO001

3. Click Enter to fill in the Type and # cells according to the number of signals automatically (blue cells below).
Note: these fields cannot be edited.

Type # SignalName

Location

Barcode PartNumber SinA SinB SinC ModuleName path SignalName
PRTNMBO0O1

4. Enterthe Sin numbers (red cells below)

Barcode PartNumber SinA SinB SinC ModuleName Lo;g:::m SignalName

5. Select the first active cell from the Bar code column (orange cell above).
Repeat steps 1-5 for every other module you want to add.
6. From the Excel, click Save.

The file is now ready to be imported.

Import an Excel file

Excel Import tab
From Module manager menu > Excel Import tab you can add the modules imported by the file.
Two parts compose the Excel Import tab:
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Templates H5BUS DALI2 Excel Import

Modules
Clra x 2 Q
Part Number SinObject Name LocationPath
r @ B4X_L54 U 123111212 Push buttons - Morth side Default\Floor1WOfficel
Element Description

Multifunction panel (A) @
: adds or updates all the imported devices

Imported modules (B) | For each module, a row containing the following information is created:

Column Description
Multi-status  According to the status, the icon can be a command or a
icon feedback:
Type Icon Description

Command @ Adds module to configuration

g Updates module to configuration

Feedback & Module SIN not valid
Module part number not valid
@ Mod_ule already presentin the
configuration
Part Number Module part number
SIN object Module SIN address

Name Module/signal name. You can change the default one in
the Excel file.
Path Path created by the user. If you don't specify it, the field

remains empty.

How to import a fulfilled Template file

1. From Module manager > Import section > Excel File, click Import Excel file
2. Select and open the Template file: the system starts to check the file for data consistency.
3. The available modules will be added to the Excel list(on the left of the Module manager menu).

See the table describing the fields.

4. From the Networks tab in the central panel, select the master channel generator to which you want to add
the modules.
Notes:
- the selected row turns grey.
- only the SH2MCG24 or SBP2MCG324 Master Channel Generators are allowed. If no master channel
generator is present, a new module will be added.

5. Inthe Location tab, select the Location where you want to add the modules.
Otherwise, the location tree will be created according to the file specification and the modules added
accordingly.

71 UWP IDE | User manual v. 5.0 | 13/11/2023 | UWP IDE | © 2023 CARLO GAVAZZ] Controls SpA

<4



b4 > Procedures

See Location.

6. Add or update the modules to the project using the icons of the Excel Import tab.

Location_
Import modules to predefined locations

When the path is added to the Excel, the system splits it into single strings using \ as a separator and then looks
for the Root.

If... Then...

The system does not find any string Creates a Root
The system does not identify the string The modules will be added according to the association order
There are duplicated strings The modules will be added to the first relevant location

You select the new location The new module will be added to it

Import file Excel with modules without location
If you don't specify the path in the Excel file, the new module is added to the location you select.

Fix a template with errors

In the Excel Import tab, in case of not valid row, you will see the & icon.

1. Hover over the & icon to open the information pop-up.
2. Fixthe Excelfile.
3. Import the fixed Template file.
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Create an offline project with Smart Dupline® modules

1. Open the File menu
2. Click New project

3. From the Home page, access the Module manager menu

4. From the Templates tab, add the modules manually (@)

@ 3 [3 ® ©

MName Ver
3 Maodbus RTU
3 Maodbus TCP
4 Smart-Cupline
] Light switch
] Decentral Digital 1/C:
3 Decentral Analogue |
3 Alarm products
3 Meotion Detectors
4 Temperature
(&7 SHA4XTEMDIS 132
[#Y SHESXTEMDIS 12
(&Y SHEK«TEMDIS 14

I-T-j SHALXLSZTEMDIS 1

L

5. Leave the module SIN set to 000.000.000 (see the picture below).

Path Ref Name Address
‘ il Default SH2MCG24 (5 000.000.000
I-T*_‘ ma, Bus current
T'J W Bus voltage
T, % Lal
i Default SHESXLS2TEMDIS G 000000.000

Rename the modules/signals and use them inside the functions so to create the project offline
As soon as you go to the field, upload the project

Connect to the controller

© ® N o

Access the Module manager menu again

10. Open the Discovery menu ( %.8 ) and select the HSBUS full discovery so to find all the connected
submaster modules
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(C?\)

11. Click Find compatible modules found with quick/full discovery to filter the found modules by

those compatible with the module selected

Modules 4 M & Default  SH2MCG24 Gy 000.000.000
@( @ @ Q '-"J mA Bus current
Part Number SIN LLP FwRev | St.. ' 1'J v Bus voltage
F @ stemcca 001.011.123 202 Re. T, % Lal
(E5 SHERALEETE . IR E S [T Default  sHEsxLsziemDis G0 000.000.000

12. Select the module from the list
Note: the selected module will be marked in grey

]9

13. Click Apply SIN of selected modules to selected module in installation (‘- D) to assign the SIN to
the module used for filtering

Modules
0%
L@
Part Mumber
« [F @ smamcez4
g SHESXLS2TEM...

14. Repeat the previous steps for all the modules with SIN set to 000.000.000

15. Click Save and close to write the project and configure the system
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Replace a faulty module previously used in the configuration

o M 0w N =

10.
1.

75

Open the File menu

Open your project

From the Home page, access the Module manager menu
Select the faulty module from the list

Replace physically the faulty module by connecting the new one to the bus.
Notice: join or divide the modules ONLY when they are NOT power supplied

Open the Discovery menu ( %8 ) and select the HSBUS full discovery to find the new module

Click Find compatible modules found with quick/full discovery(C?\) to filter the found modules by
those compatible with the module selected

Select the new module from the list
Note: the selected module will be marked in grey

]9

Click Apply SIN of selected modules to selected module in installation (> D) to assign the SIN to
the module used for filtering

Click Save and close

Send the configuration to the controller again to configure the new module with the faulty module settings
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Change module network

1. From the Home menu bar, access the Module manager menu
2. Place the mouse over the module whose network you want to change

3. Drag and drop the module under the new generator
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Copy and paste modules

1. From the Home menu bar, access the Module manager menu.

2. rrom the Modules area (in the centre of the window), mark ( ) the item row whose properties you want
0 copy.

Note: the copied item row becomes green (see the picture below).

Module mansger

DE B & @ & Q& Bk

Home Sawe and | Discovery RE4854 R54858 TCPAP Modbys Exermnal bus Gateway | WP/ Excel
Hame - Madbus ATU Modbus RTU  converter ™  gemerator™  Dali2  VMUCT Filew
Discovery idd subnet Import
Modules

El B D

Path Ref Name Adidress
«m @& L1 Defauilt SHAMOG24 & 000.000.000

I, mA Bus current

.-?_'J v Bus volitage

I, % L
-
OB L1 Default BAKLS4U & 000000000
O HE L1 Default BAXLS4U & 000000000
O @B L1 Default BAKLS4U € 000000000
v i D L1 Default BAXLEAL & 000000000
O HE LY Default BANLESAY & 000.000.000

3. Check the item rows where you want to paste the properties.

Note: the destination item rows that have similar specifications to the first selected are highlighted in orange. The
system uses the “Type” and “Index” tags to identify items with similar specifications.

4. Click ljzl to open the Copy and paste properties panel

5. Check the properties to be pasted to the items highlighted in orange
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Module manager

(A G 0 &BRr
Home Brsciary (225 RG4S TOPAP Miodbas Ectermad bus Gabeway VWP Escel
- Modben ATU Mlodbui ATU comverter™ generater™ Dueli2  WMLC™ R~

e
&
o

Crscovery Add psbnet Irrpenei
Maodules
Bl b & B Bd (b €
Piame 1| Addes |
«m W & Copy and pate propertiey IWCG24 @ oonmonm
rT\'JmA | €t

Matchung nues: Warkiame and -

Apphy pagty

6. Click Apply paste to confirm the changes

7
7. Click (Remove mark) to remove the selection

> Procedures
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Clone modules

1. From the Home menu bar, access the Module manager menu

2. From the Modules area (in the centre of the window), select the item to clone

Modules

Bl (o & @

| Path | Ref | Mame
TR L1 Default SH2MCG24
vl I-.T'__. mA Bus current
¥l I-.T'__. ¥ Bus voltage
o T, % Lal
Ml L1 Default SHPINNI2

3. Clickg--| (Clone selected module)

4. From the Clone settings, select the modules to add as clone and the other options (see picture below)

Modules Diriver Test

el (o & &

Add modules copying from selected module

Mumber of module to add 1 :
Paste module global properties v
Paste module Name v
Paste module Note o
Paste commeon signal properties o
Paste specific signal properties v

Paste signal Name

Paste signal MNote

Add

5. Click Add to confirm the changes and clone the module(s)
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Delete modules

1. From the Home menu bar, access the Module manager menu.

2. Click @ to delete the module from the configuration.
Note: the master channel generator modules cannot be deleted if there is at least one module in their network.
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Set the data logging

From the Home page
1. From the Home page
2. From the Project tree tab, select an object

3. Click % (Configure data logging for selected signals) to open the logging options.
Note: the panel shows the available logging options according to the signal types you have checked.

For example, if you have selected just analogue signals, the panel shows only the Analogue input signals menu.

4. Click Apply log settings to assign the selected options to the signals
Note: in the Modules area, the Log column shows the signals saved on the database.

From the Module manager
1. From the Home page, access the Module manager menu
2. From the Modules networks area (in the centre of the window), check the signals where you want to set the

data logging (as shown below)

Path Ref MName
4 H ﬁ]‘]‘ E L1 Default SHZMCG24
v '-?-«_‘ ma Bus cumrent
W E IR Bus voltage

3. Click % (Configure data logging for selected signals) to open the logging options
Note: the panel shows the available logging options according to the signal types you have checked.

For example, if you have selected just analogue signals, the panel shows only the Analogue input signals menu.

4. Selectthe log type, the sampling time and other parameters

5. Click Apply log settings to assign the selected options to the signals
Note: in the Modules area, the Log column shows the signals saved on the database.
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Functions

Content
This chapter includes the following sections:

FUNCHON St MU 83
WO L 84
COUN BT 99
ANalogUE COMPAratOr .. 109
MU Gt . 125
Matn e M atiCal .. 136
ANAlOGUE UL DU 150
MOaDUS QU DULS 162
Al aTN 174
COUN T AlAIMN 191
HOU COUNTING o 207
0N N UG T 215
AN I UG O 232
S O 249
DAYt 262
I eIVl IO 273
YOl C M 282
LGNt 290
OO 321
SO UG .o 338
CalEN Al 354
Smart Calendar 366
ZONE tOMIPEIAtUIE . 378
S S M MO I A UNE . . 414
VNGl NEatiNG . 428
ASTrONOMICAl ClOCK .. 444
Al SIS 454
Terms and CONAItONS ... . 466
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Function list menu

'k Home > Building / Energy > Function list
The Function list changes according to the application you select (Energy or Building).
Each function has its own dedicated page for setting the relevant parameters.
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Switch

Content
This section includes the following topics:

Introduction to the SwitCh fUNCHION ... 85
SWIlCN PaGE 86
SO G S o 87
TrQQEr SIONAlS 90
AU M At ONS 91
Force ON and OFF CONAitiONS ... oo 93
AVailable ACtONS . 95
PrOCEAUNES . 96
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Introduction to the Switch function

The Switch function can be used to switch one or more digital outputs ON and OFF. You can add a Local
Calendar to schedule the function activities.

You can also set the Switch function to turn the output OFF according to a delay timer.
Please refer to the following examples to better understand the operating mode.

Example 1

The Switch function replicates on the output the status of the input (trigger signal). When the trigger signal for ON
is activated, the function output goes ON. When the trigger signal for OFF is activated, the output goes OFF.

Function output

ON

OFF

Y

ON: OFF: ON 'OFF

Trigger signal

L J

Example 2
When the Switch function turns ON, the Timer OFF starts. When the time expires, the output goes automatically
OFF.

Function output

ON

OFF

v

EON with timeout

Trigger signal

L 4

! Timer counts down
Timer OFF = 530" oo >
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Switch page
* Home page > (Building) > Function menu > Switch
Switch A
L Name Switch
A) 5o O -
Home Save and = Show location Show user Path L1 Default
Home tree note
D ~
Basic settings Options Function signals 4
E
Options
Timer OFF 00:00:00 Ei
Command signals Disable timer  00:00:00 EJ
B
Output signals
Feedback signals
C
Local calendar
>
Area Description
A Toolbar: navigation buttons, icon setting, function name
B  Settings. It displays the following function tabs:
« Options, sets the function parameters and signals.
« Command signals, sets the command signals to trigger the actions.
« Output signals, sets the output signals driven by the function.
« Feedback signals, sets the feedback signals to show the function status.
« Local Calendar, sets calendar events to automate the function according to time
schedules
For further information, see "Settings" on the next page
C  Central area: shows the available options according to the selected tab
D  Sub-menu: shows the available sub-menus according to the selected tab
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Settings

Options tab
The Options tab has two sub-menus (on the top-right): Options (default) and Function signals.
From the Options sub-menu, you can set the following parameters:

Parameter Description

Timer OFF Sets the time period before the output switches
OFF (0 - 24 h. Default value: 1 min)

Disable timer Sets the time period after which the Disable ON
condition is deactivated (0 - 24 h. Default value: 1
min)

OFF status string (web app) Sets the string for the ON condition displayed in
the web app

ON status string (web app) Sets the string for the OFF condition displayed in
the web app

From the Function signals sub-menu, you can see the list of the available types of signal and the relevant
settable statuses.

Element Description Value

Main signal Shows the function status OFF = Function is not active
ON = Function is active

Status signal Shows the function status Status Value shown
1 Output OFF
2 Output ON
3 Output ON
with time-out
4 Disabled,
output OFF
5 Disabled,
output ON
6 Forced ON,
output ON
Custom signal Itis ON if the status selected ON = The selected status is true
from the combo-box is true OFF = The selected status is
false

For further information, see "Procedures" on page 96 (Functions> Switch > Settings > Options tab > Function
signals)

Command signals tab

The Command signals tab shows the list of all the available input signals.

The Switch function is controlled by trigger signals that you can select from the Signal local properties panel,
according to the signal type.

The following table shows the types of signal you can associate to the trigger actions:
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Signal type Actions that can be associated Note
Digital push button (e.g. « Trigger the output status You can add max 50 signals
SHA4XLS4TH module) » Manage the Disable
. . automation
Digital switch

« Manage the Force
Module digital (e.g. SH2INDI424 conditions
module)

Digital function

Analogue function Analog signal

For further information, see "Procedures” on page 96 (Functions> Switch > Settings > Command signals tab: Add the
command signals)

Output signals tab

The Output signals tab shows the list of all the available output signals you can select according to the function
status.

Signal type Available options

Digital output Inverted logic of the function can be enabled
Digital LED

Digital signal

For further information, see "Procedures” on page 96 (Functions> Switch > Settings > Command signals tab: Add the
output signals)

Feedback signals tab

The Feedback signals tab shows the list of all the available feedback signals you can select to check the Switch
status.

Signal type Available options
Digital LED Inverted logic of the function can be enabled
Digital

Note: You can add max 50 signals

For further information, see "Procedures” on page 96 (Functions> Switch > Settings > Command signals tab: Add the
feedback signals)

Local calendar tab

The Local calendar functionality can be used to trigger action according to time schedules.
From the Local calendar sub-menu, you can set the following parameter:

Parameter Description

Enable calendar events at start-up Executes the last missed event at the controller’s
start-up.

Note: if at the controller powering ON, the system
finds missed scheduled events, the last missed
event is executed if the trigger criteria (day and
hour) are met. When the controller is OFF, no event
can be executed
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Parameter

Description

®
@

Enable

Description

Day time

Action

Adds a new event

Removes the event selected

Enables/disables the event

Defines the name of the event that will appear on
the Local calendar |ist

Triggers the event at the specific time determined
by the option you choose from [ .

From =, you can open the Recurrence menu
and set what follows:

Days of the week. It triggers the event on the
selected week days

Days of the months. It triggers the event on the
selected days

Months of the year. It triggers the event on the
selected months

Selects the action to be performed when the time
condition is verified.

See "Available actions" on page 95 to see the
available options

For further information, see "Procedures” on page 96 (Functions> Switch > Settings > Local calendar tab)

Example

In the example below, there are two events: the first is set to turn the switch function ON every day at 9:30 (Turn
ON - blue rectangle) and to turn it OFF at 23:30 (Turn OFF — orange rectangle):

Basic settings

Enable calendar events at start-up @ ‘..;,/,
Options Description DBJJ' time Enable Action
= = =
I Turn ON 093000 = [v ON =T I
Command signals » Turn OFF 230000 [ = v OFF = m

Output signals

Feedback signals

Local calendar

89

Recurrence =

Days of the week Every day of the week «

Days of the month Every day of the month

Months of the year Every month «
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Trigger signals

Push button
Property

> Switch

Description

Enable inverted signal
Action on rising
Action on click

Action on long click

Action on very long click

Switch and digital function

Property

When flagged, the signal status operates in
inverted logic

As soon as the push button is pressed, the
selected action is executed

As soon as the push button is clicked, the
selected action is executed

After a long press, the selected action is executed

After a very long press, the selected action is
executed

Description

Enable inverted signal
Action on rising

Action on click

Analogue signal / function

Property

When flagged, the signal status operates in
inverted logic

As soon as the switch turns ON / function goes
ON, the selected action is executed

As soon as the switch turns OFF / function goes
OFF, the selected action is executed

Description

Enable digital mode

Rising mode

Falling mode

Action on rising

Action on falling

When flagged, the analogue signal is considered
as a digital signal.

Set the high threshold above which the signal is
considered ON

Set the low threshold below which the signal is
considered OFF

As soon as the function goes ON, the selected
action is executed.

Note: The analogue value must be 2 the rising
threshold Action on falling

As soon as the function goes OFF, the selected
action is executed

Note: The analogue value must be < the falling
threshold
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Automations

Automations are used in Building Automation systems to automate functions thanks to time schedules, actions
triggered by sensors or by timers.

These automations have priority over manual actions (such as the pressure of a push button ) so, if you need to
stop any automation associated to the function, you can activate the Disable ON condition.

From the Signal local properties of the Command signals tab, you can associate actions to the trigger signals.
The following tables show the types of signal according to the action behaviour:

Push Button

As soon as you After a very long

As soon as you click  After along press

press the push : press
button ( Itbt]ceti%l:\Sgr? lgltgl]() (Actlt;:\i:kr; long (Action on very
(Action on rising) long click)
Action
Disable ON The automation is disabled
Disable ON with The automation is disabled for the time period set in the Disable timer field
time-out Note: when the timer expires, the automation returns active
Disable OFF The Disable ON condition is removed

Disable ON/OFF  The automation is enabled/disabled in toggle mode
toggle

Disable ONwith  The automation is enabled/disabled in toggle mode. If the Disable ON condition
time-out/ OFF is active, the timer starts
toggle

Digital switch / digital function

As soon as the switch
closes/ the function goes  As soon as the switch closes / the function goes OFF

ON (Action on falling)
(Action on rising)

Action
Disable ON The automation is disabled
Disable ON with time- The automation is disabled for the time period set in the Disable timer
out field
Note: when the timer expires, the automation returns active
Disable OFF The Disable ON condition is removed

Disable ON/OFF toggle = The automation is enabled/disabled in toggle mode

Disable ON with time- ~ The automation is enabled/disabled in toggle mode. If the Disable ON
out/ OFF toggle condition is active, the timer starts
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Analogue signal / analogue function

As soon as the
analogue

signal/function value
goes above the below the threshold

threshold (Falling edge)
(Rising edge)

As soon as the analogue signal/function value goes

Action
Disable ON
Disable ON with time-out

Disable OFF
Disable ON/OFF toggle

Disable ON with timer/
OFF toggle

The automation is disabled

The automation is disabled for the time period set in the Disable timer
field

Note: when the timer expires, the automation returns active
The Disable ON condition is removed
The automation is enabled/disabled in toggle mode

The automation is enabled/disabled in toggle mode. If the Disable ON
condition is active, the timer starts
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Force ON and OFF conditions

If you want to force the output ON or keep it OFF regardless of the logical status of the function, select Force ON
and Force OFF.

These automation have priority over manual actions (such as the pressure of a push button ) so, if you need to
stop any automatism associated to the function, you can activate the Disable ON condition.

Note: When you activate the force output ON signal and the force output OFF signal, the force output ON signal
has the priority.

From the Command signals tab of the function you can manage the automation and the actions to
enable/disable the automation:

Push Button

As soon as you press the As soon as you click the Afteralong  After a very long
push button push button press press
(Rising edge) (Click) (Long) (Very long)
Action
Force ON The output is forced ON regardless of all the other signals used in the function

Remove force The Force ON action is removed (if the function output is forced ON)
ON

Force ON The Force ON condition is enabled/disabled
toggle

Force OFF The output is forced OFF regardless of all the other signals used in the function

Remove force The Force OFF action is removed (if the function output is forced OFF)
OFF

Force OFF The Force OFF condition is enabled/disabled
toggle

Digital switch / digital function

As soon as the switch closes or the
function goes ON

(Rising edge)

As soon as the switch opens/function goes OFF
(Falling edge)

Action
Force ON The output is forced ON regardless of all the other signals used in the function

Remove force | The Force ON action is removed (if the function output is forced ON)
ON

Force ON The Force ON condition is enabled/disabled
toggle
Force OFF The output is forced OFF regardless of all the other signals used in the function

Remove force | The Force OFF action is removed (if the function output is forced OFF)
OFF

Force OFF The Force OFF condition is enabled/disabled
toggle
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Analogue signal / analogue function

> Switch

As soon as the analogue signal/function value  As soon as the analogue signal/function value

goes above the threshold goes below the threshold
(Rising edge) (Falling edge)

Action
Force ON

Remove
force ON

Force ON
toggle

Force OFF

Remove
force OFF

Force OFF
toggle

The output is forced ON regardless of all the other signals used in the function

The Force ON action is removed (if the function output is forced ON)
The Force ON condition is enabled/disabled

The output is forced OFF regardless of all the other signals used in the function

The Force OFF action is removed (if the function output is forced OFF)

The Force OFF condition is enabled/disabled
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Available actions

The following table shows the available actions for the Switch function:

Action When the action is triggered...
ON Switches the function ON
ON with time-out Switches the function ON and starts the timer
Note: if the function is already ON, it reloads the
timer value
OFF Switches the function OFF
ON / OFF toggle Switches the function ON/OFF in toggle mode
ON with time-out / OFF toggle Switches the function ON, starts the timer and

switches the function OFF in toggle mode

Disable ON Disables the automation (such as time schedules
of a local calendar)

Disable ON with time-out Disables the automation for the time period set in
the Disable timer field

Note: when the timer expires, the automation

returns active
Disable OFF Removes the Disable ON action
Disable ON/OFF toggle The automation is enabled/disabled in toggle
mode

Disable ON with time-out / OFF toggle The automation is enabled/disabled in toggle
mode. When the Disable ON is active, the timer

starts
Force ON Forces the output ON regardless of all the other
signals used in the function
Remove force ON Removes the Force ON action if the function
output is forced ON
Force ON toggle The Force ON condition is enabled/disabled
Force OFF Forces the output OFF regardless of all the other

signals used in the function

Remove force OFF Removes the Force OFF action if the function
outputis forced OFF

Force OFF toggle The Force OFF condition is enabled/disabled
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Procedures

N 1
® Functions > Switch > Settings > Options tab > Function signals

Edit the function signal names

1. From the Options tab, click Function signals on the top-right area to access the Signal properties panel
2. From the central area, select the signal you need to change.

3. Type a name in the text box.

Set the predefined value of the Custom signal

1. From the Options tab, click Function signals on the top-right area to access the Signal properties panel
2. From the Signal properties panel, click to see the available statuses
3. Select the status you want to assign to the Custom signal

Note: its value is ON when at least one of the selected status is true

(N2 2
A Functions> Switch > Settings > Command signals tab

Add the command signals
1. From the signal list, select the input signals you want to add to the configuration.

Notes:
o When a signal is selected, it appears in the central area
o Everytime a signal is added, a new row is created.
2. Select the signal by checking the box from the Properties panel

3. From the Signal local properties panel, set the options according to the configuration

Add the output signals
1. From the signal list, select the output signals you want to add to the configuration.

Notes:
o When a signal is selected, it appears in the central area
« Everytime a signal is added, a new row is created.
2. Select the signal by checking the box from the Properties panel.

3. From the Signal local properties panel, set the options according to the configuration.

Add the feedback signals
1. From the signal list, select the feedback signals you want to add to the configuration.

Notftes:

1For further information, go to Switch > Settings > Options tab

2For further information, go to Settings > Command signals tab
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o When a signal is selected, it appears in the central area

o Everytime a signal is added, a new row is created.

2. Select the signal by checking the box from the Properties panel

3. From the Signal local properties panel, set the options according to the configuration

Set the feedback modes

1. From the Main signals list, select the feedback signals you want to set

2. From the Signal local properties panel, set the Feedback mode for each Function status

3. From the Feedback mode column, you can select the following different options:

If you select... Then...
OFF The feedback signal stays OFF
ON The feedback signal stays ON

Fast flashing
Flashing

Slow flashing
Enable blinks

Blinks Number

Enable custom
Ton (s)

Toff (s)

N

The feedback signal flashes quickly
The feedback signal flashes normally
The feedback signal flashes slowly

You have to set the number of blinks

You see the number of blinks (default value: 1
blink)

You have to set the Ton and Toff values
You see the time period during which the

feedback signal stays ON (default value: 1
second)

You see the time period during which the
feedback signal stays OFF (default value: 1
second)

1

A Functions> Switch > Settings > Local calendar tab

Add an event

AW~

Edit an event: change the time

1. Inday view, touch and hold the event.

From the central area, click @ (centre-right corner).
Fill in the event details (description, start/end times, how often it repeats).

From the Actions combo-box, select the action to perform.

From the Enable column, select the check box to enable the event.

2. Dragitto a new time or adjust the grab points.
3. Change the time of an event and any of the other event details.

1For further information, go to Switch > Settings > Local calendar tab
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Edit an event: change the event details
1. Select the event.

2. Select Edit (top right corner).
3. Inthe event details, select the setting / field you want to change.

Delete an event
1. Select the event you want to delete

2. From the Local calendar tab, click @

N

® Functions > Switch

Customize a function
1. From the toolbar, select a custom icon you want to assign to the function.
Note: The selected icon will be shown both in the UWP IDE and in the Web-App. When a signal is selected, it appears
in the central area.
2. From the toolbar, you can also change the function name in the text box.
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> Counter

Counter

Content

This section includes the following topics:

Introduction to the Counter fUNCHON . . 100
COUN T PG ..o 101
SO NG S 102
TGO SIONAIS . 106
PO AU S . 107

99
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Introduction to the Counter function

The Counter function is mainly used to acquire pulses from input signals for counter applications (energy, water,
gas) or count part.

You can then adjust the acquired values and use them independently by using, for instance, push buttons or
remote commands.

The possible applications are the following:
+ Pulse counter

Note: the UWP 4.0 controller must always be online to monitor the input signals (contacts). During the download of a
configuration the function does not operate (this means the pulses are lost).

« Generation of an adjustable value

You can set the function to generate a value by using manual or remote commands. This is useful to perform
threshold variations, simulations, tests.

Note: The generated value can be used as a signal in other functions.
« Sum of analogue/counter variables with offset handling

The Counter function can sum analogue values or values coming from a counting module. The function can also
be used as a virtual energy meter to sum up the values coming from different meters or different input modules
such as SH2INDI424, SHPINCNT4, SHPINCNTS04 and SHJWINS04xxx.

+ People counting

The function always counts the counter-linked variables (input value); the adjustable value can be
enabled/disabled by a command.

If the function is disabled (Adjustable value frozen) any adjustable value is ignored, while signals used as input
values continue to be counted.
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Counter page
'k Home page > (Building) > Function menu > Counter

" Counter A
Q %D % Name Counter

Home Save and = Show location Show user Path L1 Default
Home tree note
D A
Settings Options Function signals [x

o DR
phions Enable rollover counter

Command signals

Input signals

Feedback signals B

Local calendar C

>

Area Description

A Toolbar: navigation buttons, icon setting, function name
B  Settings. It displays the following function tabs:

« Options, sets the function parameters and signals.
« Command signals, sets the command signals to trigger the actions.

« Input signals, sets the input signals to count the pulses
« Feedback signals, sets the feedback signals to show the function status.

» Local Calendar, sets calendar events to automate the function according to time
schedules

For further information, see "Settings" on the facing page
C  Central area: shows the available options according to the selected tab

D  Sub-menu: shows the available sub-menus according to the selected tab
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Settings

Options tab

> Counter

The Options tab has two sub-menus (on the top-right): Options (default) and Function signals.
From the Options sub-menu, you can set the following parameters:

Parameter

Description

Measure unit

Resolution

Max adjustable limit/ Min adjustable limit

Enable adjustable rollover counter

Selects the unit of measure for the counter value.
Itis used as label in the UWP IDE and web app

Sets the decimal point position used in the UWP
IDE and web app to represent the counter value
according to your needs. The selection does not
affect the calculations (sum differences of counter

signals).

Note: the UWP 4.0 controller applies the resolution
also after the calculations. If you acquire pulses
from a signal with a resolution greater than the
function's one, the differences will probably be lower
than the resolution you set, and the Counter value

won't increase

Sets the minimum/maximum limits of the

adjustable value.

Ifitis...

Then...

Checked

Unchecked

the counter
value exceeds
the min/max

The counter
value is forced
to the value
defined in the
Max

adjustable
limit / Min
adjustable
limit fields
(above
mentioned)

Value > max ->
value=value -
(max-min)
Value < min ->
value=value -
(min-max)

From the Function signals sub-menu, you can see the list of the available types of signal and the relevant

settable statuses.

Element Description

Total value Shows the total counting value. This

field does not show the measure
unit, nor the resolution format
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Element

Description Value

Status signal

Custom signal

Adjustable value
Input value

Adjustable rollover counter value

Shows the current function status The adjustable value can be
related to the adjustable counting ~ enabled/disabled
functionality

Value
Status shown
1 Adjustable
counting is
enabled
2 Adjustable
counting is
disabled
It is ON if the statuses selected from ON = The selected status is
the combo-box is true true
OFF = The selected status
is false

Shows the counter value related to
the adjustable counting value

Shows the counter value related to
counter input signals

Shows the option status Value
Status e

0 The option
is checked

1 The option
is
unchecked

For each signal you can set the available properties in the Signal global properties panel.

Command signals tab

The Command signals tab shows the list of all the available signals.
The Counter function is controlled by trigger signals that you can select from the Signal local properties panel,

according to the signal type.

The following table shows the types of signal you can associate to the trigger actions:
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Signal type Actions that can be associated Note

Digital push button « Increment/decrement the You can add max 50 signals
adjustable value

Digital switch o Enable/disable the adjustable
counting value

Module digital (e.g. SH2INDI424 . Manage the rollover counter
module)

Digital function
Analogue function

Analogue signal

Input signals tab
The Input signals tab shows the list of all the input signals that can be used as counters.

In this tab, you can add any analogue signals and the Counter function calculates the sum of the counting values
coming from different signals. The result of the function is the sum of the twocounting values:

Counter function= Counter 1+ Counter 2+ Counter n

The Counter function can be used as a virtual energy meter to sum up the values coming from different meters or
it can be used to sum up the counting values coming from different input modules.

The following table shows the types of signal you can add:

Signal type Note
Pulse counter signal (e.g. SH2INDI424 module) You can add max 50 signals
Digital switch

Digital function
Analogue function

Analogue signal

Feedback signals tab

The Feedback signals tab shows the list of all the available feedback signals you can select to check the
Counter status.

Signal type Available options
Digital LED Inverted logic of the function can be enabled
Digital

Note: You can add max 50 signals

Local calendar
The Local calendar functionality can be used to trigger action according to time schedules.
From the Local calendar sub-menu, you can set the following parameter:
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Parameter

Description

Enable calendar events at start-up

®
@

Enable

Description

Day time

Action

105

Executes the last missed event at the controller’s
start-up.

Note: if at the controller powering ON, the system
finds missed scheduled events, the last missed
event is executed if the trigger criteria (day and
hour) are met. When the controller is OFF, no event
can be executed

Adds a new event

Removes the event selected

Enables/disables the event

Defines the name of the event that will appear on
the Local calendar |ist

Triggers the event at the specific time determined
by the option you choose from [F) .

From =, you can open the Recurrence menu
and set what follows:

Days of the week. It triggers the event on the
selected week days

Days of the months. It triggers the event on the
selected days

Months of the year. It triggers the event on the
selected months

Selects the action to be performed when the time
condition is verified.
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Trigger signals

Push button

Property Description

Enable inverted signal  When flagged, the signal status operates in inverted logic
Action on rising As soon as the push button is pressed, the selected action is executed
Action on click As soon as the push button is clicked, the selected action is executed
Action on long click After a long press, the selected action is executed

Action on very long click After a very long press, the selected action is executed

Switch and digital function

Property Description

Enable inverted When flagged, the signal status operates in inverted logic
signal

Action on rising As soon as the switch turns ON / function goes ON, the selected action is
executed

Action on click As soon as the switch turns OFF / function goes OFF, the selected action is
executed

Analogue signal / function

Property Description
Enable digital mode When flagged, the analogue signal is considered as a digital signal.
Rising mode Set the high threshold above which the signal is considered ON
Falling mode Set the low threshold below which the signal is considered OFF
Action on rising As soon as the function goes ON, the selected action is executed.

Note: The analogue value must be = the rising threshold Action on falling

Action on falling As soon as the function goes OFF, the selected action is executed
Note: The analogue value must be < the falling threshold
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Procedures

N

® Functions > Counter > Settings > Options tab > Function signals

Edit the function signal names

1. From the Options tab, click Function signals on the top-right area to access the Signal properties
2. From the central area, select the signal you need to change
3. Type a name in the text box

Set the predefined value of the Custom signal

1. From the Options tab, click Function signals on the top-right area to access the Signal properties
2. From the Signal properties, click to see the available statuses
3. Select the status you want to assign to the Custom signal

N

® Functions > Counter > Command signals

Add the command signals
1. From the signal list, select the input signals you want to add to the configuration.

Notes:
* When a signal is selected, it appears in the central area.
» Every time a signal is added, a new row is created.
2. Select the signal by checking the box from the Properties panel

3. From the Signal local properties, set the options according to the configuration

Add the input signals
1. From the signal list, select the input signals you want to add to the configuration.

Notes:
» When a signal is selected, it appears in the central area
* Every time a signal is added, a new row is created.
2. Select the signal by checking the box from the Properties panel
3. From the Signal local properties, set the options according to the configuration

4. From the Signal global properties, set the option according to the configuration

Add the feedback signals

1. From the signal list, select the feedback signals you want to add to the configuration.

Notes:
* When a signal is selected, it appears in the central area
* Every time a signal is added, a new row is created.
2. Select the signal by checking the box from the Properties panel

3. From the Signal local properties, set the options according to the configuration
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Set the feedback modes
1. From the Main signals list, select the feedback signals you want to set.

2. From the Signal local properties, set the Feedback mode for each Function status

3. From the Feedback mode column, you can select the following different options:

If you select... Then...

OFF The feedback signal stays OFF

ON The feedback signal stays ON

Fast flashing The feedback signal flashes quickly

Flashing The feedback signal flashes normally

Slow flashing The feedback signal flashes slowly

Enable blinks You have to set the number of blinks

Blinks Number You see the number of blinks (default value: 1
blink)

Enable custom You have to set the Ton and Toff values

Ton (s) You see the time period during which the
feedback signal stays ON (default value: 1
second)

Toff (s) You see the time period during which the
feedback signal stays OFF (default value: 1
second)

N

® Functions > Counter

Customize a function
1. From the toolbar, select a custom icon you want to assign to the function.

Note: The selected icon will be shown both in the UWP IDE and in the Web-App. When a signal is selected, it appears
in the central area.

2. From the toolbar, you can also change the function name in the text box.
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Analogue comparator

Content
This section includes the following topics:

Introduction to the Analogue comparator funCtion ... ... . 110
ANAlOGUE COMPAIATOr .. . 111
SO NG S 112
TGO SIONAIS . 121
PO AU S . 122
Local calendar ProCEAUIES ... . . 124
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Introduction to the Analogue comparator function

The Analogue comparator is a function that compares two values: the Real value, such as the value of one or
several input signals, and the Reference value, such as a low / high thresholds that can either be fixed according
to your needs or read by external references.

Moreover, thanks to this function you can decide whether the given input value has to be compared according to
the high/low thresholds; the Analogue comparator function in fact can be set according to different comparator
modes (see "Comparator type" on page 117).

A specific numeric value can be set for the output function ON and OFF: this way, the function can be used to warn
you when a monitored signal or condition goes out of the required value / condition and, in the context of building
automation, to control other functions or signal.

You can also add the following triggers to change the comparison type:
« Command signals, such as a push button, digital function
« Calendar event

« Another Analogue comparator function
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Analogue comparator

) Home page > (Building) > Function menu > Analogue comparator

Comparator A

Q %D :’P. i Name Comparator

Home Save and = Show location Show user Path L1 Default
Home tree note

Settings Options Function signals

_ D L
e Output value when comparator is OFF 0

Output value when comparator is ON 1

4 4

Command signals Input signals management Average

High threshold signals management Average ¥
Input signals Low threshold signals management Average ¥
Output signals
Feedback signals
Local calendar C
>
Area Description

A Toolbar: navigation buttons, icon setting, function name
B  Settings. It displays the following function tabs:

« Options, sets the function parameters and signals.

« Input signals, sets the alarm input signal to activate the alarm ON condition.

« Output signals, sets the output signals driven by the function.

« Feedback signals, sets the feedback signals to show the function status.

« Reference by external function, comparator reference linked to an external Analogue
comparator function.

For further information, see "Settings" on the facing page
C  Central area: shows the available options according to the selected tab

D  Sub-menu: shows the available sub-menus according to the selected tab
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Options tab

> Analogue comparator

The Options tab has two sub-menus (on the top-right): Options (default) and Function signals. From the

Options sub-menu, you can set the following parameter:

Parameter

Description

Measure unit

Resolution

Max input limit / Min input limit /
Default input (when not valid)

External references

Comparator type

Output value when comparator is OFF

Output value when comparator is ON

Input signals management

Selects the measure unit for the function value. It
is used as label in the UWP 3.0 Tool and in the
Web-App

Note: the selected measure unit does not impact the
resolution of the function value

Sets the resolution value according to your
requirements. The selection does not affect the
calculations (sum differences of counter signals)

Sets the minimum/maximum limits the input value
can assume

Input value used as default before receiving a
valid value

Enables the possibility to link another comparator
function whose settings and thresholds are
inherited

Sets the parameters according to the selected
Comparator type

See Comparator type for field description and
working mode

Sets the output value of the function when the
Analogue comparator function is OFF

Sets the output value of the function when the
Analogue comparator function is ON

Selects how to treat the input signals. The
available options are the following:

o AVG. Uses the average value of all signals
presentin the Input signals tab as input.

e MIN. Uses the minimum value among the
signals present in the Input signals tab as
input.

« MAX. Uses the maximum value among the
signals present in the Input signals tab input.
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> Analogue comparator

Parameter

Description

High threshold signals management Selects how to treat the input signals to get the
High reference value. The available options are
the following:

AVG. Uses the average value of all signals
present in the Input signals tab as high
reference.

MIN. Uses the minimum value among the
signals present in the Input signals tab as
high reference.

MAX. Uses the maximum value among the
signals present in the Input signals tab as
high reference.

Low threshold signals management Selects how to treat the input signals. The
available options are the following:

AVG. Uses the average value of all signals
present in the Input signals tab as low
reference.

MIN. Uses the minimum value among the
signals present in the Input signals tab as low
reference.

MAX. Uses the maximum value among the
signals present in the Input signals tab as low
reference.

From the Function signals sub-menu, you can see the list of the available types of signal and the relevant

settable statuses.
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Element

Description

> Analogue comparator

Value

Main status

Status signal

Custom signal

Analog output signal

Input value
High threshold

Low threshold

Shows the current function
status

Shows the current function
status

Itis ON if the statuses selected
from the combo-box is true

Shows the output value
according the set parameters

Shows the input value
Shows the high threshold

Shows the low threshold
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OFF = Analog function is OFF
(the comparison is not verified)

ON = Analog function is ON (the
comparison is verified)

Shows the function status
among those values:

Value Status
1 OFF

2 OFF (Delay
ON running)

ON

ON (Delay
OFF running)

5 OFF
(Comparator
disabled)

6 ON
(Comparator
disabled)

You can associate several
function statuses, as described
in the Status signals

description

Refers to the following
parameters set from the
Options tab:

e Output value when
comparator is OFF

o Output value when
comparator is ON

The value can be:

o Fixed, i.e. set manually in the
Comparator type field (
Options tab )

¢ Dynamic, by using input
signals as high threshold in
the Input signals tab

The value can be:

o Fixed, i.e. set manually in the
Comparator type field (
Options tab )

o Dynamic, by using input
signals as high threshold in
the Input signals tab
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> Analogue comparator

Input signals tab

The Input signals tab shows the list of all the available input signals that can be used as input reference value to
be compared according to the low and/or high thresholds.

Here you can also define if the value of a signal has to be used as high or low threshold instead of fixed value set
in the Comparator type parameters ( Options tab).

The following table shows the type of signals you can associate:

Signal type Notes
Digital signals Digital signal that « Inthe Signal global properties panel, the
belongs to the functions available options change according to the
signal type.
Digital signal that e See Input Signals properties to configure the
belongs to the modules input signals accordingly to the Group field.
(i.e. B4X-LS4-U)

: » You can add max 50 signals
Analog signals Analog signal that
belong to functions

Analog signal that
belong to modules

Input Signals properties
In the Input signal properties area, for each input signal the following option is proposed:

If the Group flsld Is Then the input signal is ...

set to...

Input used as real reference value
Note: the real reference signal has priority over the threshold limit and the latter is
used only if a fault should occur to the real reference signal

High reference used as a dynamic high threshold
Note: If you do not set any input signal as high threshold, or if all the signals value is
invalid, the Analogue comparator function works according to the fixed high
threshold configured in the field Comparator type in the Options tab.

Low reference used as a dynamic low threshold

Note: If you do not set any input signal as high threshold, or if all the signals value is
invalid, the Analogue comparator function works according to the fixed high threshold

configured in the field Comparator type in the Options tab
Note: from the Options tab you can set the calculation mode (Average, Maximum, Minimum)).

Output signals tab

The Output signals tab shows the list of all the available output signals you can select according to the function
status.

Signal type Available options

Digital output
Digital LED

Inverted logic of the function can be enabled

Note: You can add max 100 signals
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v > Analogue comparator

Feedback signals tab

The Feedback signals tab shows the list of all the available feedback signals you can select to check the Alarm
status.

Signal type Available options
Digital LED
Digital

Inverted logic of the function can be enabled

Note: You can add max 50 signals

External references tab

From the External references tab, you can link an external Analogue comparator function for gathering the
comparator settings. This way, you can have several analogue comparators working according to just one set of
parameters: for each function, you have to set only the Measure unit and the Resolution.

Al2

d"

Comparator

\%
g
I
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\V/
RAE[E| |RA([E[E)||®A[EE

Alarm

<

R

Comparator

— | Ref

Comparator
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Comparator type

Moreover, from the Options tab, in the Comparator type field you can select the comparator working mode that
and set the relevant parameters:

Parameter Description

Comparator type Sets the Comparator mode:
Note: the parameters are shown according to the Comparator type selected

Option Comparison modes to activate

the alarm
Higher than (hysteresis %) ON when the value is = High
threshold
OFF when the value is < High
threshold - HIGH Level * HIGH
hysteresis (%) / 100
Higher than (hysteresis = low threshold) ON when the value is = High
threshold
OFF when the value is < Low
threshold
Lower than (hysteresis %) ON when the value is < Low
threshold
OFF when the value is > Low
threshold + LOW Level * LOW
hysteresis (%) /100
Lower than (hysteresis = high threshold) ON when the value is < Low
threshold
OFF when the value is > High
threshold
Inside low and high thresholds ON when value is inside the Low
and High threshold
Outside low/high thresholds ON when value is outside the
Low or High thresholds
Disable comparator, status OFF The comparator algorithm is
disabled and the analogue output
status is set to OFF
Disable comparator, status ON The comparator algorithm is
disabled and the analogue output
status is set to ON
External analogue comparator reference Comparator reference is linked
to an external analogue
comparator function. See
"Settings" on page 112 >
External reference
High threshold Sets the value for the High threshold. When the analogue signal value goes above the
threshold, the condition is activated
Hysteresis (%) Sets in percentage the hysteresis value for the High threshold
Low threshold Sets the value for the Low threshold. When the analogue signal value goes below the
threshold, the condition is activated
Hysteresis (%) Sets in percentage the hysteresis value for the Low threshold
Delay ON (s) Defines the delay before the activation of the Analogue comparator function when the
comparison is true
Delay OFF (s) Defines the delay before the deactivation of the Analogue comparator function when

the comparison is false.

Note: these are the same fields for setting the Comparator type to command signals or calendar events
(Dynamic behaviour tab)
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Comparator type: Lower than hysteresis %
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Comparator type: Inside LT and HT
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Trigger signals

In the Signal local properties panel, according to the signal type you can see the following parameters.

Push button

Property Description
Enable inverted signal  When flagged, the signal status operates in inverted logic
Action on rising As soon as the push button is pressed, the selected action is executed
Action on click As soon as the push button is clicked, the selected action is executed
Action on long click After a long press, the selected action is executed

Action on very long click After a very long press, the selected action is executed

Switch and digital function

Property Description

Enable inverted When flagged, the signal status operates in inverted logic
signal

Action on rising As soon as the switch turns ON / function goes ON, the selected action is
executed

Action on click As soon as the switch turns OFF / function goes OFF, the selected action is
executed

Analogue signal / function

Property Description

Enable digital mode When flagged, the analogue signal is considered as a digital signal.

Rising mode Set the high threshold above which the signal is considered ON
Falling mode Set the low threshold below which the signal is considered OFF
Action on rising As soon as the function goes ON, the selected action is executed.

Note: The analogue value must be = the rising threshold Action on falling

Action on falling As soon as the function goes OFF, the selected action is executed.
Note: The analogue value must be < the falling threshold
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Procedures

N

w Functions > Analogue comparator > Settings > Options tab > Function signals

Edit the function signal names

1. From the Options tab, click Function signals on the top-right area to access the Signal properties
2. From the central area, select the signal you need to change
3. Type a name in the text box

Set the predefined value of the Custom signal

1. From the Options tab, click Function signals on the top-right area to access the Signal properties
2. From the Custom column, click to see the available statuses
3. Select the status you want to assign to the Custom signal

N

w Functions > Analogue comparator > Settings > Command signals

Add the input signals
1. From the Input signal list, select the input signals you want to add to the configuration.

Notes:
» When a signal is selected, it appears in the central area
* Every time a signal is added, a new row is created.
2. Select the signal by checking the box from the Main signal panel
3. From the Group field, set the input property among Input, Low or High threshold

4. From the Signal global properties, set the options according to the configuration

Add the output signals

1. From the signal list, select the output signals you want to add to the configuration.

Notes:
* When a signal is selected, it appears in the central area
» Every time a signal is added, a new row is created.

2. Select the signal by checking the box from the Main signal panel
3. From the Type field, set the condition the output is activated among Warning or Alarm

4. From the Signal local properties, set the options according to the configuration

Add the command signals
1. From the command signal list, select the input signals you want to add to the configuration.

Notes:
» When a signal is selected, it appears in the central area
* Every time a signal is added, a new row is created.
2. Select the signal by checking the box from the Properties panel

3. From the Signal local properties, set the Comparator type according to the configuration
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Add the feedback signals

1. From the signal list, select the feedback signals you want to add to the configuration.

Notes:

» When a signal is selected, it appears in the central area

* Every time a signal is added, a new row is created.

2. Select the signal by checking the box from the Properties panel

3. From the Signal local properties, set the options according to the configuration

Set the feedback modes

1. From the Main signals list, select the feedback signals you want to set.

2. From the Signal local properties, set the Feedback mode for each function status

3. From the Feedback mode column, you can select the following different options:

If you select... Then...
OFF The feedback signal stays OFF
ON The feedback signal stays ON

Fast flashing
Flashing

Slow flashing
Enable blinks

Blinks Number

Enable custom
Ton (s)

Toff (s)

N

The feedback signal flashes quickly
The feedback signal flashes normally
The feedback signal flashes slowly

You have to set the number of blinks

You see the number of blinks (default value: 1
blink)

You have to set the Ton and Toff values

You see the time period during which the
feedback signal stays ON (default value: 1
second)

You see the time period during which the
feedback signal stays OFF (default value: 1
second)

® Functions > Analogue comparator

Customize a function

1. From the toolbar, select a custom icon you want to assign to the function.

Note: The selected icon will be shown both in the UWP IDE and in the Web-App. When a signal is selected, it appears

in the central area.

2. From the toolbar, you can also change the function name in the text box.
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Local calendar procedures

* Home > Functions > Analogue comparator > Local calendar tab

Add an event

From the central area, click @ (centre-right corner).

Fill in the event details (description, start/end times, how often it repeats).

From the Action combo-box, select the action to perform.

PO N -~

From the Enable column, select the check box to enable the event.

Edit an event: change the time

1. Inday view, touch and hold the event.
2. Dragitto a new time or adjust the grab points.
3. Change the time of an event and any of the other event details.

Edit an event: change the event details

1. Select the event.

2. Select Edit (top right corner).

3. Inthe event details, select the setting / field you want to change.

Delete an event
1. Select the event you want to delete

w

2. From the Local calendar tab, click
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Multigate

Content

This section includes the following topics:

<

Introduction to the Multigate fUNCHON ... 126
MU GATE PG ..o 127
SO NG S 128
PrOCEAUINES . 133
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Introduction to the Multigate function

The Multigate function can be used for executing a logical operation with one or more inputs and with one output
condition.
The function input is a list of signals; the output is a digital signal controlled by the value of the formula associated.

Following are the actions that you can perform with a Multigate function:

« Collect signals from different monitoring points (e.g., door contacts or window switches in an Alarm
function).

« Monitor signals and/or functions to get quickly a status overview.

You can use a formula value as the input of another formula so to get a single custom logical function.
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Multigate page

'k Home page > (Building)/Energy > Function menu > Multigate

Multigate

A

Q %C] m) , Name Multigate

Home Save and | Show location Show user
Home tree note D

Settings

Path L1 Default

~

Options Function signals 4

Formula 1

Output signals C
>
Area Description
A Toolbar: navigation buttons, icon setting, function name.
B  Settings. It displays the following function tabs:
» Options, selects the formulas and manages the signal names.
« Formula 1, edits the formula 1.
« Formula 2, 3, 4, edits additional formulas. These tabs will be shown only if the related
check box is enabled from the Options tab.
« Output signals, sets the output signals driven by the formula values
For further information, see "Settings" on the facing page
C  Central area: shows the available options according to the selected tab
D  Sub-menu: shows the available sub-menus according to the selected tab
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Settings

Options tab
The Options tab has two sub-menus (on the top-right): Options (default) and Function signals.
From the Options sub-menu, you can set the following parameters:

Parameter Description

Enable formula 2
Enable formula 3 Enables the relevant Formula tab

Enable formula 4

Note: you can enable a formula even if you do not need to edit it. This way you can send a command to force a value. If you
do not enable the formula, you cannot force the value.

The Function signals sub-menu shows the list of the available function signals and the relevant statuses:
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Element Description Value

Formula signal Shows the function status:

status (default,

For each formula, you can see its
value

Formula 1/2/3 or Status Value
4 signal) I
1 OK OFF (0)
2 OKON (1)
3 Not valid input
4 Formula
5 Formula not used
6 Forced OFF(0)
7 Forced ON (1)

Note: you can rename each signal (Name field) with the operator used in the formula.

Formula tab

Description

The formula
status is OK
and is False

(0)

The formula
status is OK
andis True

(1)

The input
value used in
the formula is
not valid

The formula
calculation is
not correct.

Check the
formula
syntax since it
could be
wrong.

The formula
value is not
used by the
function
outputoras
input by
another
function.

The formula
status is
forced to OFF

(0)

The formula
status is
forced to ON

(1)

The Formula 1, 2, 3 or 4 tabs permit you to access the input signals and the logical operation of the function by

selecting the keyboard.
Following is the window structure:
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Formula 1

Element Description

Main signalspanel, shows the list of all the

A available signals in the current configuration

Selected signals panel, shows the signals
B added from the Main signals panel, available for
the formulas.

Formula editor tab. The keyboard permits you to
edit the formula for the selected signals and to
C test the formula.

Formula steps tab, shows how the system
calculates the formula.

Main signals panel
This panel shows the types of signal you can use as input signals in the formula. Following are the signal types:

Signal type Notes
Digital signal Digital signal belonging to  From the Signal global
functions properties you can manage
additional parameters for each
Digital signal belonging to signal.
modules (i.e. B4X-L.S4-U)  You can add max. 50 signals
Function status Analogue signal belonging to
functions

Analogue signal belonging to
modules

Selected signals panel

This panel shows the signals you added to the Multigate function and that are available for the formula
calculation. Following are the parameters for each signal:

Parameter Description

Check it to enable the signal

Signals Shows the index identifying the signal in the

system
Path Shows the function/signal name and icon
Name Shows the function/signal type

UWP IDE | User manual v. 5.0 | 13/11/2023| | © 2023 CARLO GAVAZZI Controls SpA 130



> Multigate

Parameter Description

Permits simulating the signal value, setting the
Test value valueto O or 1.

Note: the default value is O for all the signals added.

Formula panel
This panel contains a keyboard with the following elements:

Elements Description
Edit formula E:;t\)/:/)sé’;ge formula syntax and permits editing it manually through the
Keyboard See the table below.
Formula steps Shows the steps followed by the system to calculate the formula
Keyboard elements
Element Description
S Permits adding to the formula the identifier for an input signal
Note: if the signals are added automatically, this operation is not needed.
Permits using a formula value as the input of another formula. Following are the
different syntaxes:
« O1 represents the syntax to use the formula 1 value as input.
0 « O2 represents the syntax to use the formula 2 value as input.
« O3 represents the syntax to use the formula 3 value as input.
« O4 represents the syntax to use the formula 4 value as input.
() Adds two round brackets
( Adds an opening round bracket
) Adds a closing round bracket
0-9 Adds the numeric index representing the signal to be added to the formula.
N.B.: the index has to go after an S if referred to a signal in the Selected signals tab.
OR Applies the logical operator OR to the selected signals
AND Applies the logical operator AND to the selected signals
XOR Applies the logical operator XOR to the selected signals
NOR Applies the logical operator NOR to the selected signals
NAND Applies the logical operator NAND to the selected signals
NOT Applies the logical operator NOT to the selected signals
Checks if the formula is correct and verifies the system steps in the Formula steps
Check tab. This way, it is possible to understand if the operation has been correctly

calculated.
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Output signals tab

> Multigate

The Output signals tab shows the list of all the available output signals that can be controlled by the function

main status according to the formula result.

Signal type Available options

According to your requirements, the parameters
for each output signal are the following:

Working type

Behaviour

Digital output Inverted

Formula 1 Out
Formula 2 Out
Formula 3 Out

Formula 4 Out
Digital LED

You can enable the
inverted logic of the
output

The output takes the
Formula 1/2/3 or 4
status

In the Signal global properties panel, you can
manage additional parameters.

Note: You can add max 50 signals
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Procedures

N2

w Functions > Multigate > Formula tab

Edit a formula
1. From the Main signals list, select the input signals to add to the configuration.

Notes:
o When you select a signal, it appears in the Selected signals list.
. The Signalscolumn indicates the signal identifier. S1 is the first signal.

2. From the Selected signals panel, select the input signals by checking the relevant boxes.

3. From the keyboard, select the logical operator to be applied to the selected signals

Notes:
. In the Edit formula field you see the formula syntax
o In this box you can edit manually the formula value

Use a formula output as input for another formula

Note: to use a formula value as input for another formula, you have to activate at least two formulas.

1. Click O from the keyboard to add the output identifier.
2. According to the formula used as input signal, enter the numeric identifier.

Example: if in the Formula 2 you want to use the Formula 1 value, enter O1.

3. From the Selected signals panel, select the input signals you want to use in the calculation by checking

the related boxes

4. From the keyboard, select the logical operator to apply to the selected signals and another formula value.

Notes:
. In the Edit field you see the formula syntax.
. In this box you can edit manually the formula value.
Example:
1. Formula 1 applies the AND logic between the S1 and S2 signals:
Settings
W || Signals Path Name
Options v vl 51 (1) L1 Default F1 Switch 1 Main signal
B I ) .
vl 52 (1) L1Default F2 Switch 2 Main signal
Formula 1 s3 (1) L1 Default F4 Switch 3 Main signal
Formula 2 (51 AMD 52)
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2. Formula 2 applies the OR logic between the Formula 1 and S3 signal:

Settings
B || Signals Path
Options 51 'U} L1 Default F1 Switch 1
-2 s2 () L1 Default F2 Switch 2
Formula 1 v vl 53 (1) L1 Default F4 Switch 3
O10R 53
Fermula steps
Formula 3
5 7 g 9 OR
Formula 4 e 4 : & AND
1 2 3 MOR
Cutput signals ] ( 0 ) NOT
Checl Press Check to calculate the

Test a formula

FxSwitch 04
Main signal

Main signal

NOR
MNAND

XMNOR

Mame

> Multigate

1. From the Test value column (Selected signals list), for each signal you can simulate the signal value (0 - OFF

and 1 - ON), through spin box.
Note: the default value is 0 for all the signals.

2. Click Check from the keyboard to see the value simulated by the formula.

Note: if you select the Formula steps tab, you can verify the steps the systems follows for calculating the formula.

(S0 AND S1) OR (S0 AND 52) AND O3

Formula editar

Step “1** Operand Operator "2** Operand
24 S0 (1) AndLogic 51(0)
3B 50 (1) AndLegic 52 (1)
1A 24 (0) OrlLogic 3B (1)
0 14 (1) AndLegic 03 (0

N

® Functions > Multigate > Output signals tab

Add the output signals

1. From the Main signals panel, select the output signals you want to add to the configuration.

Notes:
. When a signal is selected, it appears in the central area
. Every time a signal is added, a new row is created.

2. Select the signals from the Selected signals panel

Result

L T =

3. From the Type field, select for which formula value you want to pilot the output
4. From the Signal global properties panel, you can manage additional parameters
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s/

w Functions > Multigate

Customize a function
1. From the toolbar, select a custom icon you want to assign to the function.

Note: The selected icon will be shown both in the UWP IDE and in the Web-App. When a signal is selected, it appears
in the central area.

2. From the toolbar, you can also change the function name in the text box.

Edit the function signal name

1. From the Options tab, click Function signals on the top-right area to access the Signal properties
2. From the central area, select the signal you need to change
3. Type a name in the text box

Set the predefined value of the Custom signal
1. From the Options tab, click Function signals on the top-right area to access the Signal properties

v
2. From the Signal properties, click to see the available statuses
3. Select the statuses you want to assign to the Custom signal

Note: its value is ON when at least one of the selected statuses is true.
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Mathematical

Content
This section includes the following topics:

Introduction to the Mathematical fUNCHON ... . 137
MathematiCal PAGE ... o 139
SO NS 140
PO AU S 146
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Introduction to the Mathematical function

The Mathematical function provides you with a set of mathematical operations for two or more digital or analogue
input signals.

Following are the available operations:

Average, gives the average value among the input signals (Selected signals panel).

Maximum, gives the maximum value among the input signals (Selected signals panel).

Minimum, gives the minimum value among the input signals (Selected signals panel).

Algebraic operations, such as addition, subtraction, multiplication, division, logarithm, square root,
exponentiation.

« Linear approximation, calculates an analogue output through a curve defined by the user.

« Derivative, calculates the signal derivative within an interval of time defined by the user.

Calculate a derivative

* See "Settings" on page 140> Keyboard > Operators

The Mathematical function can be used to calculate the derivative. The derivative value (deintegration of the b
value within the interval) is calculated as (b2-b1)/T where b1 is the value at the beginning of the interval T and b2
the value at the end.

The interval can be set from the Formula editor tab, using the Derivative time field of the keyboard and can be of
5,10, 15, 20, 30, 60 minutes or 24 hours.

As soon as the time expires, the system calculates the derivative new value as the difference between the current
value (b2) and the previous one (b1) divided by the time (T as fraction of one hour).

At the first start, the derivative value will be Not valid until the first valid value of b1 will not be available, according
to the T value. As soon as the time expires, the derivative will be calculated using the formula

(b2-b1)/T
where b2 is the variable new value. After that, b2 will be the new b1.

Example of derivative calculation

Derivative Time: 5 minutes

t0:00:03:00 =y b1 = Not valid, b2 = Not valid, derivative = Not valid
t1:00:05:00=) b1 =10, b2 = Not valid, derivative = Not valid
t2:00:10:00 =y b1 =20, b2 =10, derivative = (20-10)/ (T/60)
t3:00:15:00 = b1 = 30, b2 =20, derivative = (30-20)/ (T/60)

Notes:

. in case of system reboot, the derivative value will be saved in the database restore. The next values will be
calculated according to the algorithm described before.

. If you change the time, the derivative value will be that previously calculated and the next values will be calculated
according to the algorithm but starting from the new time.

. If you cannot read the variable value or if the value is not valid, the derivative value will not be valid and as soon as
the variable value will be available again it will be possible to use the algorithm described before to recalculate the
variable.

o If b2- b1 is negative, the not valid value is restored and the calculation is repeated.
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3 If the variable does not change quickly, there could be some incorrect values. In that case, you should save and
calculate the derivative before the time expiring.

0y

£ 3 See "Procedures” on page 146 > Calculate a derivative
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Mathematical page

'k Home page > (Building) > Function menu > Mathematical

Mathematical A

LLI Name Mathematical
A 2o ER

Home Save and Show location Show user Path L1 Default
Home tree note

D ~

Options Function signals 4

Settings

- E

Formula 1 C

>

D R

Area Description

A Toolbar: navigation buttons, icon setting, function name
B  Settings. It displays the following function tabs:

« Options, sets the function parameters and signals.
« Formula 1, defines the list of signals to be used in the calculation formula.
« Formula 2, 3, 4, tabs of additional formulas. Enable the relevant tab from the Optionstab.

For further information, see "Settings" on the facing page
C  Central area: shows the available options according to the selected tab

D  Sub-menu: shows the available sub-menus according to the selected tab
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Settings

Options tab
The Options tab has two sub-menus (on the top-right): Options (default) and Function signals.
From the Options sub-menu, you can set the following parameters:

Parameter Description

Enable formula 2
Enable formula 3 Enables the relevant Formula tab
Enable formula 4

Note: you can enable a formula even if you do not need to edit it. This way you can send a command to force a value. If you
do not enable the formula, you cannot force the value.

The Function signals sub-menu shows the list of the available function signals and the relevant statuses:

Element Description Value
Mathematical Each formula The signal value is the result of the formula calculated by
signal1,2,3,4 has its output means of statistic, algebraic, linearisation or derivation
signal operators.
Each output signal can be used as input signal in other
functions.

Please see the other functions for further details.

Note: there can be max. four output signals (one for each formula activated from Options tab > Options)

You can change the signal name or force the default name visualization (Name field).

From the Signal global properties you can set the local and global properties (such as the pulse weight, resolution
or measure unit) of the signal.

Formula tab

The Formula 1, 2, 3 or 4 tabs permit you to access the input signal selection. Moreover, thanks to the keyboard,
you can define the formula according to statistic, algebraic, linearisation and derivation operators.

By default the Formula 1 tab is enabled and from the Options you can enable the other Formula tabs.
Following is the window structure:

Settings

aQ % O S
Fath Name S " o

Formula 1

B
c
Element Description
A Main signals panel, shows the list of all the available signals in the current configuration
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Element Description

B Selected signals panel, shows the signals added from the Main signals panel, available
for the formulas. From this panel you can Add, Move, Select or Remove a row.

The operands in the formula are named S1, S2, S3 and so on, according to the order
assigned in the Signals column.

C From the Signal global properties for each signal you can change the resolution. This way,
the formula can calculates accurately. Following are the properties that you can manage:

« Signal TAG
o Measure unit
« Resolution

¢ Minimum

e Maximum

o Default

« Offset

« Enablelog

Note: these properties can be changed according to the signal type.

The If not valid field has the following options:
o Default
¢ Minimum / Maximum

« Lastvalid

Note: for a not valid value the default is applied.

e 0
e Null
D Formula section. Following are the different tabs that you can manage:

Tab Description
Thanks to the keyboard you can edit the formula for the selected

Formula signals and test the validity.

editor Note: the system considers the selection order of the signals used in
the formula syntax.

Formula Shows the formula syntax. The syntax can be automatically compiled

editor with the previously selected signals and operators (from the keyboard)

or manually edited by users.

Linearisation

\ You can change the linearisation curve.
curve editor 9

Important note: the input signal properties do not depend on the function where they are used. You can also change them
from each window where the signal appears, from the Signal global properties panel. Any change to a parameter will be
applied to all the configuration.

Main signals panel

This panel shows the types of signal you can use as input signals in the formula. The input signal can be any
physical signal (such as energy, power, energetic current, temperature, humidity, brightness and so on) or also
output signals of other functions of the configuration.

Following are the signal types:
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Signal type Notes

Digital signal belonging to
Digital functions

signal Digital signal belonging to
. « From the Signal global properties you can manage
modules (i.e. B4X-LS4-U) additional parameters for each signal.

Analogue signal belonging to o You can add max. 50 signals
Function functions

status Analogue signal belonging to
modules

Selected signals panel

This panel shows the signals you added to the Mathematical function and that are available for the formula
calculation. Following are the parameters for each signal:

Parameter Description

Check it to enable the signal

Signals Shows the index identifying the signal in the system
Path Shows the function/signal name and icon
Name Shows the function/signal type

Permits defining the value to test the formula.
Notes:

Testvalue This value is considered only to check the formula and has nothing to do with the default
value that can be applied to the signal.

. The default value is 0 for all the signals added.

Formula panel
This panel contains a keyboard with the following elements:

Elements Description
Edit formula Shows the formula syntax and permits editing it manually through the keyboard
Keyboard Please go to "Keyboard" on the next page

Formula steps Shows the steps followed by the system to calculate the formula
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Keyboard

The following elements compose the keyboard.

Numeric

keypad

Fa| nula steps Linearization curve editor
Signal refe- e 7 8 9 + - * / Operators
rences o 4 5 & MAX MIN AVG -
1 2 3 SQRT LG k] LIN
(=) { 0 J DER | Derivative Time: ST
| Chech Press Che ate the re
Element Description
Signal Permits selecting the operands for the formula calculation.
references
Element Description
Permits adding to the formula the identifier for an input signal
S Note: if the signals are added automatically, this operation is not
needed.
Permits using a formula value as the input of another formula.
Following are the different syntaxes:
« O1 represents the syntax to use the formula 1 value as input.
o)

« O2 represents the syntax to use the formula 2 value as input.
« O3 represents the syntax to use the formula 3 value as input.

« O4 represents the syntax to use the formula 4 value as input.

Constants  You can add a constant to the formula.
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Element Description

Operators Can be unary, binary or multiple:

« Aunary operation is an operation with only one operand. Following are the unary

operators:
Editing
Operator Description formula Result
text
SQRT Squareroot  (SQRTDb) SQRT(b)
LIN (LIN b) LIN(b), with the curve coordinates
DER (DERDb)  Derivative of the signal B within the interval

T (s). The system calculates the discrete
derivative (b2-b1) / T where b1 is the value
at the beginning of the interval and b2 is the
value at the end of the interval.

« Abinary operation uses two operands (between two terms). Following are the
binary operators:

Operator Description Editing formula text Result
LOG (aLOGDb) Log with base b of a LOG
% (@a%b) a% ofb %
A (a’b) a’b A

A multiple operation uses two or more operands (always between two terms).
Following are the multiple operators:

Operator Description Editing formula text Result

+ (a+b) atb +

- (a-b) a-b -

* (a*b) a*b *

/ (a/b) alb /

MAX (a MAX b) Max of (a, b) MAX
MIN (a MIN b) Min of (a, b) MIN
AVG (@a+b)/n Average of (a, b) - n = number of operands AVG
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Element

Description

Numeric
keypad

145

Contains the buttons below:

Element

Description

(-)
(
)

0-9

Check

Adds two round brackets
Adds an opening round bracket
Adds a closing round bracket

You can add a reference to a signal if then you select S or O. You can
also add a constant.

Checks if the formula is correct and verifies the system steps in the
Formula steps tab. This way, it is possible to understand if the
operation has been correctly calculated.
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Procedures

N

® Functions > Mathematical > Formula tab

Select the input signals

1. From the Mail signal list of the Formulas tab, select the input signals you want to add to the Selected signals
list.

2. As soon as the signal is added, from the Signalscolumn you will see the unique identifier (starting from S1).

Remove the selected signals

From the Mail signal list of the Formulas tab, click @l to remove the relevant signal.

Notice: if a formula contains a reference to a signal you have removed, the consecutive signal input value will be
considered and the formula result will change.

Edit a formula
1. From the Selected signals list, select the input signals by checking the relevant boxes.

Note: the order in which the input signals are selected will be applied to the formula. For example, in case of division, if
you select S2 before S1, the syntax of the formula will be (S2/S1).

2. From the Keyboard, select the operator you want to apply.

If you select... Then in the Edit Formula field...

a unary operator with one operand you get ([operator] Signal)

a binary operator with two operands you get (Signal a [operator] Signal b)

multiple operators with two or more you get (Signal a [operator] Signal b [operator]
operands Signal c¢)

all the other cases you get only the operator

Note: in the Edit formula box you can always change the formula value manually.

3. Click Check to simulate the formula using the value entered in the Test value column.

Note: you can test the formula also reusing previous formulas (syntax O1-4). Go to "Use a formula output as input
for another formula" below

Use a formula output as input for another formula
Note: to use a formula value as input for another formula, you have to activate at least two formulas.
The system executes the calculation of formulas following this order: 1, 2, 3, 4.

If the system uses the Formula 1 output in the Formula 2, the value of the Formula 2 will update. If the system uses
the Formula 2 output in the Formula 1, the Formula 1 result will be that of the previous interaction.

For this reason, you have to properly order the formulas.
Notice: if you use a formula output value that has not yet been calculated , you will see the Formula not valid status. This
condition resolves automatically as soon as the value is calculated / updated.

1. Click O from the keyboard to add the output identifier.
2. According to the formula used as input signal, enter the numeric value.

Example: if in the Formula 2 you want to use the Formula 1 value, enter O1.
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Define the values to test the output signals

Open the Function signals tab (from the Options menu)
From the Test value column, enter the value as follows:

If you want to use the test value...

Then set the value to...

<

01
02
03
04

Test a formula

Mathematical signal 1
Mathematical signal 2
Mathematical signal 3

Mathematical signal 4

1. From the Test value column (Selected signals list), for each signal you can simulate the signal value (0 - OFF
and 1 - ON), through spin box.

Note: the default value is O for all the signals.

2. Click Check from the keyboard to see the value the formula simulates.

Following are some examples.

(51+52 +53)
5 7 9

o 4 3
1 3

( )

elln v|w

©

Step Operand  Operator  Operand
52(15)
s3()

1A S1010) Add
0 14(25) | Add

Example 1

Define a linearisation curve

max

SQRT

DINT

LoG % uN
1min «
33

Result Note

25
33

(51+52+53)"54

o 4 s i mAx

) « o ) oINT
Cheat

Step Operand  Operator Operand Result
24 [S1010)  |Add S2(15) 2
A 5) | Add 3 (8) 2]

0 [1A@)  [Mulipy |s4(0) 0

Example 2

(reference to an input signal not

in the list)

3:
0| Variable [$4] ot found

(51+52) /53
/ s 7 i s

o 1 B c mAx

Tmin ~ “ ( o ) oI

D

Step Operand  Operator  Operand  Result
1A (s100)  |Add 52 (15) 25
0 [1A@5) |Dwide 30 o

Note

Example 3 (division by 0).

In this example, the division by 0

is considered a not valid condition
and the signal value is replaced
with the default value or with the
value set in the If not valid field.

Through a linearisation curve, you can set the X/Y coordinates to convert an input signal value. This linearised
signal can be used as input signal in other functions.

Formula editor

1000

500

147

Formula steps

]

200

10

i

20

i

30

q b

500

qp

100
150
400

1023

4k 4F 4F

4 F
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If you want... Then... Note
a linearisation point  Enter the X/Y coordinates The input vglues that are not included in the curve are
in the table to calculate the linearised ~ replaced with Y/X.

value
toseethe Y and X Hover over the desired . The X coordinates are ordered automatically
coordinates point before applying the calculation (the representation

on the table does not change).

o In the formula, you cannot use a linearisation
curve of another signal.

. You can drag and drop the linearisation curve from
a signal to another.

Use case 1 - example of compensation of the heating threshold

In this example, the Mathematical function is used to balance a boiler water temperature according to the
external temperature. If the external temperature is lower, the water temperature increases to get a better
response from the heating system.

In the Formula tabs, you can select an external temperature (e.g., coming from the BSI-TEMANA-U module) as
input signal.

If the external temperature is... Then the water temperature will be...

sthan0°C 45°C
0-18°C

>than 18°C 20°C
12°C 28°C

In the Linearisation curve editor tab, you can set the coordinates according to the conditions described in the

table above. Moreover, you can add (@) or remove a row ( @, ).

@
X

i

Y 45 3

qF

18 20 5

-
20

0 10

After defining the curve, from Formula editor > Selected signals you have to select the temperature signal and
click LIN on the keyboard. Doing so, you will see the following syntax:

LIN S1

Calculate a derivative

1. From the Selected signals list of the Formula tabs, select the input signals you want to use for the derivative
calculation.

2. Select DER from the keyboard to complete the formula or edit the formula manually.

3. Setthe interval value from the Derivative Time field.
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s/

“® Functions > Mathematical

Customize a function
1. From the toolbar, select a custom icon you want to assign to the function.

Note: The selected icon will be shown both in the UWP IDE and in the Web-App. When a signal is selected, it appears
in the central area.

2. From the toolbar, you can also change the function name in the text box.

Edit the function signals name

1. From the Options tab, click Function signals on the top-right area to access the Signal properties
2. From the central area, select the signal you need to change
3. Type a name in the text box

Set the predefined value of the Custom signal
1. From the Options tab, click Function signals on the top-right area to access the Signal properties

v
2. From the Signal properties, click to see the available statuses
3. Select the statuses you want to assign to the Custom signal

Note: its value is ON when at least one of the selected statuses is true.
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Analogue output

Content
This section includes the following topics:

Introduction to the Analogue output fUNCHION ... . 151
ANAlOgUE OUIPUL PaGE .. . 152
SO NS 153
TGO S NS 158
PO AU S 159
Local calendar ProCEAUIES ... . . 161

UWP IDE | User manual v. 5.0 | 13/11/2023| | © 2023 CARLO GAVAZZI Controls SpA 150



<

> Analogue output

Introduction to the Analogue output function

The Analogue output function permits you to connect one or more system signals to an analogue output module.
The function manages the following types of signal:

« 10V signals (SHPOUTV224 module). This type of signal is an industrial standard that transmits a value to
a panel meter or to an actuator (e.g. pump, boiler, fan). The programmability of the output signal permits
also to manage the 0-1 V/0-5V industrial signals.

r . .
+ Input signal 1 —> Min
- . ' Output
+ Input signal 2 | Processing |pay > >
= Input Max input range
~*, Input signain AVG
- ®
) Forced value » .
Min input range

g Default Forced value R

—@
@ Default input value .

10. Analogue output functioning
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Analogue output page

* Home page > (Building) > Function menu > Analogue outputs > Analogue output

Analogue output A

Q %D Name Analogue output
2 B g

Home Save and = Show location Show user Path L1 Default

Home tree note
Settings Options Function signals »
_ D L
Options )
Disable timer 00:05:00 =
Output refresh timer 00:05:00
Input signals
Wiaiting time for writing 00:00:05
Command signals
Analogue outputs
Feedback signals
Local calendar
>
Area Description

A Toolbar: navigation buttons, icon setting, function name

B  Settings. It displays the following function tabs:

o Options, sets the function parameters and signals.

« Input signals, sets the input signals to change the function output status.

« Command signals, sets the command signals to trigger the actions.

« Analogue signals, sets the output signals driven by the function.

« Feedback signals, sets the feedback signals to show the function status.

¢ Local calendar, sets calendar events to automate the function according to time
schedules.

For further information, see "Settings" on the next page
C  Central area: shows the available options according to the selected tab

D  Sub-menu: shows the available sub-menus according to the selected tab
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Settings

Options tab

The Options tab has two sub-menus (on the top-right): Options (default) and Function signals.
From the Options sub-menu, you can set the following parameters:

Exclude input signals
Measure unit

Resolution

Max input range

Min input range

Default forced value

Default function cutput value
Input signals management

Behaviour for disabling actions

153

D

= | Disable timer 00:05:00 £
1. ¥ | Dutput refresh timer 00:05:00 (£
100 i Waiting time for writing 00:00:05 =]
05
50 S
30 7
Average

o

4

Disable input signals
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Description
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Parameter

Description

Exclude input
signals

Measure unit

Resolution

Max input range /
Min input range

Default forced value

Default function
output value

Input signal
management

Behaviour for
disabling actions

If you enable it, the input signals will not be considered and
the Input signals tab will not be shown.

When this functionality is enabled, the output signals are
changed when the function receives a command from
Modbus/BACnet or the Web App.

Selects the measure unit for the function value.
Notes:

o the selected measure unit does not impact the resolution of
the function value.

o it will be used as label in the UWP IDE and in the Web-App.
Sets the resolution value according to your requirements.

Sets the minimum/maximum limits the input value can
assume

Defines the forced value that is applied at the first Force
command if you don't specify any value.

Defines the value that is applied to the output at the system
start-up if no signal is connected or if all the output signal
values are Not valid.

Selects how to treat the input signals. The available options
are the following:

» AVG. Uses the average value of all signals present in the
Input signals tab as input.

¢ MIN. Uses the minimum value among the signals present
in the Input signals tab as input.

« MAX. Uses the maximum value among the signals
present in the Input signals tab input.

Notes:

o If the Exclude input signals parameter is activated, this
value will not be shown.

o If an input value is Not valid, the average calculation will not
be affected.

Defines the behaviour of the Disable condition when active:

« Disable inputs. The input variation does not change the
output.

« Disable calendar. Only the calendar events are
disabled.

« Disable inputs and calendar. Both the automatisms are
disabled.
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Element Description
B Parameters you can change from the Live signals panel:
Parameter Description
Disable Sets the time period after which the Disable ON condition is
timer deactivated. (0 - 24 h. Default value: 5 minutes).
Refresh Sets the refresh time to rewrite the output values periodically (0 - 24 h.
output Default value: 5 minutes).
timer
If this parameter is setto... Then...
as soon as the timer expires, the
function rewrites the output value.
another value than zero When the timer expires or the
output value changes, the Refresh
output timer recharges.
the output values are not rewritten
zero )
automatically.
Waiting Sets the refresh period (0 - 24 h. Default value: 5 seconds) after which
time for the output value is updated (written). The timer starts as soon as the
writing writing is executed; the function does not execute any other writing

until the timer expires.

If this parameter is setto... Then...

it filters writings that come in

another value than zero . .
succession quickly

the output values are updated

zero (written) after any change.

From the Function signals sub-menu, you can see the list of the available types of signal and the relevant

statuses.

Element

Description Value

Status signal

Function value signal

Writing error signal

155

Value Status
1 Disabled

Running

Shows the function status

Disabled, timeout is
running

It can be the value calculated by the
connected input values or by the

Function value value assumed as soon as a
Disable or Force condition is
verified.

Shows the status of the writing

N = writing error
commands O g erro

OFF = no writing error
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Element Description Value

Shows the status of the input ON = input signal error

Input error signal :
P 9 signals OFF = no input signal error

You can define when the custom ON = the selected status signal is
signal has to be ON according to true

the status signal selected (see OFF = the selected status signal is
above) false

Custom signal

Input signals tab

The Input signals tab shows the list of all the available input signals that can be used as input values.
The following table shows the types of signal you can associate:

Signal type Notes

bel inq to functi In the Signal global properties panel, the
_ elonging to functions available options change according to the signal
Analogue signals type.

belonging to modules You can add max 50 signals

Command signals tab

The Command signals tab shows the list of all the available signals.
The following table shows the types of signal you can associate to the trigger actions:

Signal type Actions that can be associated  Notes
Digital push button (e.g. « Refresh the output status o You can add max 50 signals
SHA4XLS4TH module) + Manage the Disable . See Available actions
Diaital switch automations

Igital switc « Manage the Force conditions
Module digital (e.g. SH2INDI424
module)

Digital function
Analogue function

Analogue signal

Analogue outputs tab

The Analogue outputs tab permits you to define the analogue output signals that are controlled by the function
main status.

Signal type Module part number Note

Analogue output signal SHPOUTV224 You can add max 50 signals

Feedback signals tab

The Feedback signals tab shows the list of all the available feedback signals you can select to check the
Analogue output status.

Signal type Available options
Digital LED ]

- Inverted logic
Digital
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Note: You can add max 50 signals

Local calendar

The Local calendar functionality can be used to trigger actions according to time schedules.
From the Local calendar sub-menu, you can set the following parameters:

Parameter

Description

Enable at controller start up

I &

w

Enable

Description
Day time

Action

157

Executes all the events at the controller start-up.

Note: if at the controller powering ON the system
finds some scheduled event, this event starts if the
trigger criteria (day and hour) are met. When the
controller is OFF, no event can be executed.

Adds an event

Defines the action recurrence. You can execute
the action on some days of the week, some days
of the month or some months of the year.

Note: settings are updated automatically every year.

Removes the selected event

Enables/disables the event

Defines the event name that will appear in the
Local calendar list

Triggers the event at the time set from the list
(HH:MM:SS:)
Selects the action to be performed when the time
condition is verified.

See "Settings" on page 153
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Trigger signals

In the Signal local properties panel, according to the signal type you can see the following parameters.

Push button

Property Description
Enable inverted signal  When flagged, the signal status operates in inverted logic
Action on rising As soon as the push button is pressed, the selected action is executed
Action on click As soon as the push button is clicked, the selected action is executed

Action on long click After a long press, the selected action is executed

Action on very long click After a very long press, the selected action is executed

Switch and digital function

Property Description

Enable inverted When flagged, the signal status operates in inverted logic
signal

Action on rising As soon as the switch turns ON / function goes ON, the selected action is
executed

Action on click As soon as the switch turns OFF / function goes OFF, the selected action is
executed

Analogue signal / function

Property Description
Enable digital mode When flagged, the analogue signal is considered as a digital signal.
Rising mode Set the high threshold above which the signal is considered ON
Falling mode Set the low threshold below which the signal is considered OFF
Action on rising As soon as the function goes ON, the selected action is executed.

Note: The analogue value must be = the rising threshold

Action on falling As soon as the function goes OFF, the selected action is executed.
Note: The analogue value must be < the falling threshold
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Procedures

s

w Functions > Analogue outputs > Analogue output > Settings > Options tab >
Function signals

Edit the function signal names

1. From the Options tab, click Function signals on the top-right area to access the Signal properties
2. From the central area, select the signal you need to change
3. Type a name in the text box

Set the predefined value of the Custom signal

1. From the Options tab, click Function signals on the top-right area to access the Signal properties
2. From the Signal properties, click to see the available statuses
3. Select the status you want to assign to the Custom signal

N

® Functions > Analogue outputs > Analoque output > Command signals

Add the input signals
1. From the Signal list panel, select the input signals you want to add to the configuration.

Notes:
» When a signal is selected, it appears in the central area
* Every time a signal is added, a new row is created.
2. From the Signal global properties, set the options according to the configuration

Tip: you can use the Copy and paste functionality to share the properties among different signals. See "Copy and
paste modules” on page 77.

Add the command signals

1. From the signal list, select the command signals you want to add to the configuration.
Notes:
* When a signal is selected, it appears in the central area
» Every time a signal is added, a new row is created.
2. Select the signal by checking the box from the Properties panel
3. From the Signal local properties, set the options according to the configuration

Tip: you can use the Copy and paste functionality to share the properties among different signals. See "Copy and
paste modules” on page 77.

Add the analogue outputs

1. From the signal list, select the analogue signals you want to add to the configuration.
Notes:

* When a signal is selected, it appears in the central area

» Every time a signal is added, a new row is created.

2. From the Signal global properties, set the properties according to the configuration.
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Add the feedback signals

> Analogue output

Tip: you can use the Copy and paste functionality to share the properties among different signals. See "Copy and

paste modules” on page 77.

1.

Noftes:

* When a signal is selected, it appears in the central area

» Every time a signal is added, a new row is created.

Set the feedback modes

From the signal list, select the feedback signals you want to add to the configuration.

2. From the Signal local properties, set the options according to the configuration

Tip: you can use the Copy and paste functionality to share the properties among different signals. See "Copy and

paste modules" on page 77.

1.

From the Main signals list, select the feedback signals you want to set.

2. From the Signal local properties, set the Feedback mode for each function status

3. From the Feedback mode column, you can select the following different options:

Customize a function

If you select... Then...
OFF The feedback signal stays OFF
ON The feedback signal stays ON

Fast flashing
Flashing

Slow flashing
Enable blinks

Blinks Number

Enable custom
Ton (s)

Toff (s)

N

The feedback signal flashes quickly

The feedback signal flashes normally

The feedback signal flashes slowly

You have to set the number of blinks

You see the number of blinks (default value: 1

blink)

You have to set the Ton and Toff values

You see the time period during which the
feedback signal stays ON (default value: 1

second)

You see the time period during which the
feedback signal stays OFF (default value: 1

second)

® FunctionsAnalogue outputs > Analogue output

1.

From the toolbar, select a custom icon you want to assign to the function.

Note: The selected icon will be shown both in the UWP IDE and in the Web-App. When a signal is selected, it appears

in the central area.

2. From the toolbar, you can also change the function name in the text box.
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Local calendar procedures

* Home > Functions > Analogue outputs > Analogue output > Local calendar tab

Add an event

From the central area, click @ (centre-right corner).

Fill in the event details (description, start/end times, how often it repeats).

From the Action combo-box, select the action to perform.

AW~

From the Enable column, select the check box to enable the event.

Edit an event: change the time

1. Inday view, touch and hold the event.
2. Dragitto a new time or adjust the grab points.
3. Change the time and any other event details.

Edit an event: change the event details
1. Select the event.

2. Select Edit (top right corner).

3. Inthe event details, select the setting / field you want to change.

Delete an event
1. Select the event you want to delete

]

2. From the Local calendar tab, click
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Modbus outputs

Content
This section includes the following topics:

Introduction to the Modbus outpUt fUNCHONS ... . 163
MOAbDUS OUIDUL PaGE ... 164
SO NS 165
TGO S NS 170
PO AU S 171
Local calendar ProCEAUIES ... . . 173
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> Modbus outputs

Introduction to the Modbus output functions

The Modbus output functions permit you to write one or more variables previously defined in a Modbus driver
created in the UWP IDE.
According to the type of variable you want to control, there are three functions available:

« Analogue output function. It permits writing the analogue variables (function codes 6 or 16)
 Digital output function. It permits writing the digital variables (function codes 1 or 2)
« Multistate output function. It permits writing the multistate analogue variables (function codes 6 or 16)

Note: each Modbus output variable must first be created at the driver level (type and format) to be then written by the
functions described above.

The Modbus output functions permit:

scaling between the output value calculated by the function and the value written in the output signal (only
analogue output through min./max. input range)

writing the output when the function value changes

forcing the output value to a defined value

periodically writing the output value (through the Refresh output timer parameter)

writing the output value from local calendar

calculating the function output value according to the input signals.

Note: the Modbus multistate output function does not support this feature.
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5 > Modbus outputs

Modbus output page

* Home page > (Building) > Function menu > Analogue outputs > Modbus output

Modbus analogue output A
Q %G Name Modbus analogue output
=l ORI E.
Home Save and = Show location Show user Path L1 Default
Home tree note
Settings Options Function signals »
_ D
Options
Disable automation timer 00:05:00 £
Input signals Refresh output timer 00:05:00 ]
Waiting time for writing 00:00:05 ]
Command signals
Analogue outputs
Feedback signals
Local calendar

>

11. Modbus analogue output

Area Description

A Toolbar: navigation buttons, icon setting, function name
B  Settings. It displays the following function tabs:

« Options, sets the function parameters and signals.

« Input signals, sets the input signals to change the function output status.
« Command signals, sets the command signals to trigger the actions.

« Analogue output signals, sets the output signals driven by the function.
« Feedback signals, sets the feedback signals to show the function status.

» Local calendar, sets calendar events to automate the function according to time
schedules.

For further information, see "Settings" on the next page
C  Central area: shows the available options according to the selected tab

D  Sub-menu: shows the available sub-menus according to the selected tab
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Settings

Options tab

The Options tab has two sub-menus (on the top-right): Options (default) and Function signals.
From the Options sub-menu, you can set the following parameters:

Exclude mput signals
Exclude CRC chack
Measure wmit

Rezalution

Max input range

Min input range

Default forced value

Default function output value
Input signal management

Behavisur for disabling sctions

D

Dhzable sutemabon bimer 000500 E

Refresh output timer 00:05:00 B

= Waiting time for writing 00:00:05 B
1. =
100
0=

50 B

Ei
Average -

Disable nput signals

A

165
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> Modbus outputs

Description
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Parameter

Description

Exclude input
signals

Exclude CRC check

Measure unit

Resolution

Max input range /
Min input range

Default forced value

Default function
output value

If you enable it, the input signals will not be considered and
the Input signals tab will not be shown.

When this functionality is enabled, the output signals are
changed when the function receives a command from
Modbus/BACnet or the Web App.
Note: the Modbus multistate output function does not support
this feature.

This option avoids the comparison between the read value
and the value written by the variable. It also permits avoiding
problems during the writing whenever the variable is “written”
also by other BMS systems.

Selects the measure unit for the function value.

Notes:

. the selected measure unit does not impact the resolution of
the function value.

. it will be used as label in the UWP IDE and in the Web-App.
. itis valid only for the Modbus analogue output function.

Sets the resolution value according to your requirements.
Note: it is valid only for the Modbus analogue output function.
Sets the minimum/maximum limits the input value can
assume.
Note: it is valid only for the Modbus analogue output function.

Defines the forced value that is applied at the first Force
command if you don't specify any value.

Defines the value that is applied to the output at the system
start-up if no signal is connected or if all the output signal
values are Not valid.
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> Modbus outputs
Element Description
A Parameter Description
Input signal Defines how to treat the input signals.
management For the Modbus analogue output function, the available

Behaviour for
disabling actions

Function status
table

167

options are the following:

« AVG. Uses the average value of all signals present in the
Input signals tab as input.

¢ MIN. Uses the minimum value among the signals present
in the Input signals tab as input.

o MAX. Uses the maximum value among the signals
present in the Input signals tab input.

For the Modbus digital output function, the available
options are the following:

« OR. Sends the value when at least one input signal is ON.
o AND. Sends the value when ALL input signals are ON.

Notes:

. If the Exclude input signals parameter is activated, this
value will not be shown.

o If an input value is Not valid, the average calculation will not
be affected.

o It is valid only for the Modbus multistate output function.
Defines the behaviour of the Disable condition when active:

o Disable inputs. The input variation does not change the
output.

« Disable calendar. Only the calendar events are disabled.

« Disable inputs and calendar. Both the automatisms are
disabled.

In this table you can define the function statuses. To each
status you can associate a label that will be displayed in live
signals and in the web app to indicate the value the function
is writing in the variable.

Note: this table is available in the Modbus digital output and
Modbus multistate output functions.
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Element Description
B Parameter Description
Disable Sets the time period after which the Disable ON condition is
automation | deactivated. (0 - 24 h. Default value: 5 minutes).
timer
Refresh Sets the refresh time to rewrite the output values periodically (0 - 24

output timer | h. Default value: 5 minutes).

If this parameter is setto... Then...

as soon as the timer expires, the
function rewrites the output value.

another value than zero When the timer expires or the
output value changes, the
Refresh output timer recharges.

7610 the output values are not rewritten
automatically.
Waiting time Sets the refresh period (0 - 24 h. Default value: 5 seconds) after
for writing which the output value is updated (written). The timer starts as soon
as the writing is executed; the function does not execute any other
writing until the timer expires.

If this parameter is setto... Then...

it filters writings that come in

another value than zero ) .
succession quickly

the output values are updated

Zero (written) after any change.

From the Function signals sub-menu, you can see the list of the available types of signal and the relevant
statuses.

Element Description Value
Value Status
1 Disabled
Status signal Shows the function status Running
3 Disabled, timeout is
running

It can be the value calculated by the
connected input values or by the

Function value signal Function value value assumed as soon as a
Disable or Force condition is
verified.

Shows the status of the writing

Writing error signal commands ON = writing error

OFF = no writing error
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Element Description

Value

Input error signal

Shows the status of the input ON = input signal error
signals

OFF = no input signal error

You can define when the custom ON = the selected status signal is

Custom signal

Input signals tab

signal has to be ON according to true

the status signal selected (see OFF = the selected status signal is
above)

false

The Input signals tab shows the list of all the available input signals that can be used as input values.
The following table shows the types of signal you can associate:

Signal type

Notes

belonging to functions

Analogue signals

belonging to modules

Local calendar

In the Signal global properties panel, the
available options change according to the signal
type.

You can add max 50 signals

The Local calendar functionality can be used to trigger actions according to time schedules.
From the Local calendar sub-menu, you can set the following parameters:

Parameter

Description

Enable at controller start up

I ®

w
Enable

Description

Day time

Action

169

Executes all the events at the controller start-up.

Note: if at the controller powering ON the system
finds some scheduled event, this event starts if the
trigger criteria (day and hour) are met. When the
controller is OFF, no event can be executed.

Adds an event

Defines the action recurrence. You can execute
the action on some days of the week, some days
of the month or some months of the year.

Note: settings are updated automatically every year.

Removes the selected event
Enables/disables the event

Defines the event name that will appear in the
Local calendar list

Triggers the event at the time set from the list
(HH:MM:SS:)

Selects the action to be performed when the time
condition is verified.

See Available actions
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Trigger signals

In the Signal local properties panel, according to the signal type you can see the following parameters.

Push button

Property Description
Enable inverted signal  When flagged, the signal status operates in inverted logic
Action on rising As soon as the push button is pressed, the selected action is executed
Action on click As soon as the push button is clicked, the selected action is executed

Action on long click After a long press, the selected action is executed

Action on very long click After a very long press, the selected action is executed

Switch and digital function

Property Description

Enable inverted When flagged, the signal status operates in inverted logic
signal

Action on rising As soon as the switch turns ON / function goes ON, the selected action is
executed

Action on click As soon as the switch turns OFF / function goes OFF, the selected action is
executed

Analogue signal / function

Property Description
Enable digital mode When flagged, the analogue signal is considered as a digital signal.
Rising mode Set the high threshold above which the signal is considered ON
Falling mode Set the low threshold below which the signal is considered OFF
Action on rising As soon as the function goes ON, the selected action is executed.

Note: The analogue value must be = the rising threshold

Action on falling As soon as the function goes OFF, the selected action is executed.
Note: The analogue value must be < the falling threshold
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<

Procedures

s

w Functions > Analogue outputs > Modbus analogue output > Command signals

Add the input signals
1.

From the Signal list panel, select the input signals you want to add to the configuration.
Notes:

When a signal is selected, it appears in the central area
. Every time a signal is added, a new row is created.
2. From the Signal global properties, set the options according to the configuration

Tip: you can use the Copy and paste functionality to share the properties among different signals. See "Copy and
paste modules” on page 77.

Add the command signals
1.

From the signal list, select the command signals you want to add to the configuration.
Notes:

When a signal is selected, it appears in the central area
. Every time a signal is added, a new row is created.

2. Select the signal by checking the box from the Properties panel

From the Signal local properties, set the options according to the configuration

Tip: you can use the Copy and paste functionality to share the properties among different signals. See "Copy and
paste modules” on page 77.

Add the Modbus analogue outputs
1.

From the signal list, select the Modbus analogue signals you want to add to the configuration.
Notes:

The configuration file must contain a Modbus driver with a valid variable to select

When a signal is selected, it appears in the central area

o Every time a signal is added, a new row is created.

Add the feedback signals
1.

From the signal list, select the feedback signals you want to add to the configuration.
Notes:

When a signal is selected, it appears in the central area

. Every time a signal is added, a new row is created.
2. From the Signal local properties, set the options according to the configuration

Tip: you can use the Copy and paste functionality to share the properties among different signals. See "Copy and
paste modules” on page 77.

Set the feedback modes

1. From the Main signals list, select the feedback signals you want to set.

2. From the Signal local properties, set the Feedback mode for each function status
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3. From the Feedback mode column, you can select the following different options:

> Modbus outputs

If you select... Then...
OFF The feedback signal stays OFF
ON The feedback signal stays ON

Fast flashing
Flashing

Slow flashing
Enable blinks

Blinks Number

Enable custom
Ton (s)

Toff (s)

N

The feedback signal flashes quickly

The feedback signal flashes normally

The feedback signal flashes slowly

You have to set the number of blinks

You see the number of blinks (default value: 1

blink)

You have to set the Ton and Toff values

You see the time period during which the
feedback signal stays ON (default value: 1

second)

You see the time period during which the
feedback signal stays OFF (default value: 1

second)

w Functions > Analoque outputs > Modbus analogue output

Customize a function

1. From the toolbar, select a custom icon you want to assign to the function.

Note: The selected icon will be shown both in the UWP IDE and in the Web-App. When a signal is selected, it appears

in the central area.

2. From the toolbar, you can also change the function name in the text box.
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Local calendar procedures

* Home > Functions > Analogue outputs > Modbus analogue output > Local calendar tab

Add an event

From the central area, click @ (centre-right corner).

Fill in the event details (description, start/end times, how often it repeats).

From the Action combo-box, select the action to perform.

AW~

From the Enable column, select the check box to enable the event.

Edit an event: change the time

1. Inday view, touch and hold the event.
2. Dragitto a new time or adjust the grab points.
3. Change the time and any other event details.

Edit an event: change the event details
1. Select the event.

2. Select Edit (top right corner).

3. Inthe event details, select the setting / field you want to change.

Delete an event
1. Select the event you want to delete

]

2. From the Local calendar tab, click
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Alarm

Content
This section includes the following topics:

Introduction to the Alarm fUNCHON . . 175
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SO NS 177
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Local calendar ProCEAUIES ... . . 190
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Introduction to the Alarm function

The Alarm function warns you when an event occurs. Events can be related to smoke alarms, water leakage
alarms or to any other event you need to b<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>